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F. Microsoft Office Professional 2003

Notiuni prezentate in acest capitol:
e aplicatile suitei Microsoft Office Professional 2003 (Word, Excel, PowerPoint,
Outlook, Access)
e tipuri de documente cu care lucreaza aplicatiile Microsoft Office Professional 2003

Scopul acestui capitol:

o familiarizarea utilizatorului cu particularitatile aplicatiilor care functioneaza sub
Windows (structura similara a meniurilor, gruparea comenzilor dupa functiuni intr-o
ordine specifica, primirea de ajutor etc.)

o familiarizarea utilizatorului cu utilizarea aplicatiior care fac parte din suita Microsoft
Office Professional 2003

e introducerea utilizatorului in crearea si modificarea diferitelor tipuri de documente

e pentru utilizatorii cu experientd anterioara in lucrul cu suita Office, ce aduce nou
aceasta versiunea fata de cele mai vechi

1. Introducere

Microsoft Office Professional 2003 este o suitd de aplicatii tip ,office” (,birou”) specifice
activitatilor care se desfagsoara de regula intr-un birou: redactarea de documente, alcatuirea
de devize, efectuarea de calcule simple si prezentarea rezultatelor in forma tabelara sau
grafica, prezentari de produse sau servicii, postda electronica si mesagerie electronica,
alcatuirea de baze de date de structura simpla.

Suita Office 2003 cuprinde urmatoarele aplicatii:

o Word, este un software dedicat crearii si modificarii documentelor. Este cea mai
utilizata aplicatie a suitei.

e Excel, este un program de calcul tabelar, cu posibilitdti de prezentare grafica a
datelor.

e PowerPoint, este un program de realizare a prezentarilor de tip diapozitiv (,slide”)
static sau animat, cu sau fara fond sonor.

e Outlook, este un program de posta electronica, cu posibilitdti de transmitere de
mesaje catre grupuri structurate, de realizare de programe calendaristice de lucru si
intalniri, vizualizare de documente etc.

e Access, este o aplicatie de definire a bazelor de date de structura simpla, de
interogare si alcatuire de rapoarte in forma tabelara sau grafica.

Lansarea aplicatiilor suitei se face la fel, prin parcurgerea secventei (Figura F.1):

Start -> All_Programs -> Microsoft Office -> Numele_aplicatiei_Office

Se observa ca fiecare aplicatie are o icoana specifica. La instalarea standard, acesta este
locul in care icoanele se plaseaza automat. Utilizatorul isi poate crea scurtaturile aplicatiilor
pe care le foloseste mai frecvent pe desktop, in meniul Start sau in zona de lansari rapide de
pe taskbar.
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Figura F.1.

Microsoft Office 2003 este un produs localizat in limba romana, asa ca la deschiderea
ferestrei de lucru se constata ca titlurile meniurilor, comenzile din meniuri precum si o buna
parte a structurii de ajutor sunt n limba roméana. Pentru aceia care cunosc aplicatiile Office
din versiuni anterioare, ca gi pentru cei care incep utilizarea aplicatiilor Office cu acest curs
este foarte important sa stie ca dispunerea meniurilor, succesiunea comenzilor, scopul si
modul lor de actiune sunt aceleasi ca si in varianta in limba engleza.

Meniurile generale sunt aceleasi in toate aplicatiile Office, exceptie facand cele care contin
comenzi specifice. Comenzile sunt o parte generale si altele specifice, cu denumiri intuitive,
astfel incat un utilizator care ajunge sa cunoasca una din aplicatii va avea un bun punct de
plecare si pentru celelalte.

2. Ajutorul in Office 2003

Ajutorul vine in mai multe forme, comune pentru toate aplicatiile Office:
2.1 Caseta ,, Tastati o intrebare”

Caseta ,Tastati o intrebare” (Figura F.2) apare in dreapta barei de meniuri (dreapta sus pe
ecran). Se introduc intrebari formulate in expresii specifice lucrului pe calculator, care sa
poata fi recunoscute. De fapt este suficientd introducerea unor termeni cheie dupa care se
va executa cautarea.

Tastati ointrebare -

Figura F.2.

2.2 , Asistentul” Office

JAsistentul” Office ofera automat termeni din meniul ,Ajutor” gi sfaturi pentru activitatile
desfasurate in timpul lucrului, chiar inainte de a pune o intrebare. De exemplu, cand scrieti o
scrisoare in Microsoft Word, ,Asistentul” poate afisa automat termeni care ajuta la crearea si
formatarea unei scrisori. ,Asistentul” poate fi particularizat si poate sa afiseze automat
termeni, mesaje si avertizari, sa produca sunete, sa se mute cand sta in cale si sa ghiceasca
un termen din ,Ajutor” de care considera ca este nevoie. De asemenea, se poate tasta o
intrebare, iar ,Asistentul” va afiga o listd de posibili termeni potriviti. ,Asistentul” afiseaza si



sfaturi despre cum se utilizeaza mai eficient caracteristicile din programele Microsoft Office.

Sfatul este afigsat cand se face click pe ,beculetul” ( /) de langa ,Asistent”. De asemenea, se
poate selecta un ,Asistent” cu aspect diferit. Se poate decide modul de ajutor. De exemplu,
pentru cei care prefera sa utilizeze tastatura in locul mouse-ului, ,Asistentul” poate fi
configurat sa afiseze sfaturi prin taste de comenzi rapide. Deoarece ,Asistentul” este partajat
de toate programele Office, orice optiuni care se modifica in unul vor fi automat preluate in
celelalte. ,Asistentul” se lanseaza din meniul ,Ajutor”, prin selectarea ,Afisare Asistent
Office”, si se obtine una din prezentarile lui posibile (Figura F.3).

ce doriti sa faceti?

Figura F.3.

Caseta in care sunteti invitati sa tastati o intrebare se comporta la fel ca si caseta , Tastati o
intrebare”, dupa ce veti apasa butonul ,Céutare”. Selectand butonul ,Optiuni” veti putea sa
va personalizati asistentul, dupa cum am aratat mai sus.

Asistent Office '|

Galerie | Optiuni

Utilizare Asistent Office
Ajukor cu experti Mutarea ferestrei cand deranjeaza
Afisare avertizari Sunete
CEutare ajukor pentru produs si pentru pragramare in timpul programrii

Afigare sfaturi despre

[liutilizarea mai eficients a carackeristicilor: Afisare doar sfaturi cu prioritate maxima

[ utilizarea mai eficients a mausuli Sfatul zilei afigat la pornire

[] Comenzi rapide de la tastaturd Reinitializare sFaturi

[ QK l ’ Revocare ]

Figura F .4.
In figura F.4. este reprezentata tableta din care puteti defini caracteristicile asistentului,
inclusiv forma acestuia, din fila Galerie.
Daca nu este nevoie de ,Asistent”, poate fi facut sa dispara prin secventa ,Ajutor/ Ascundere
Asistent Office”.

2.3 Cautare sfaturi si sugestii

Dupa introducerea termenului de cautare, in partea dreapta se va deschide o fereastra in
care vor fi afisate rezultatele cautarii, sub forma unor titluri. Prin selectarea unuia dintre
acestea se va deschide o tableta in care puteti vizualiza sau imprima (apasand butonul )
informatiile corespunzatoare. Daca informatiile astfel obtinute nu sunt suficiente sau nu se
inscriu cerintelor dumneavoastra, vor fi sugerate si alte locatii in care puteti incerca o
cautare, iar in partea inferioara a listei apare optiunea ,Nu géasiti?”. Apeland aceasta optiune
veti fi trimisi pe site-ul http://office.microsoft.com/ro-ro/assistance. Aceasta operatie afiseaza
sugestii despre cum sa efectuati cautarea gi cum sa interpretati rezultatele returnate. De
asemenea, se poate trimite feedback pentru imbunatatirea viitoarelor versiuni de ,Ajutor”.



2.4 Meniul ,Ajutor”

Meniul ,Ajutor” este prezentat in figura F.5. afisarea ajutorului pentru Microsoft Word se face
prin selectarea optiunii corespunzatoare sau apasand tasta F1. Cele mai multe optiuni va vor
duce Optiunea pe site-ul Microsoft, in diferite sectiuni ale sale: Microsoft Office Online in
sectiunea Office, pagina localizata in limba romana; optiunea Contactati-ne intr-o sectiune in
care puteti afla despre cum sa obtineti ajutor: modalitati de cautare, asistenta profesionala
(care ar putea implica si anumite costuri) si de asemenea o zona de Feedback si sugestii;
optiunea Verificéri actualizari in care puteti vedea si descarca ultimele figiere continand
actualizari emise de producator pentru una dintre componentele Office.

Detectare si reparare (Figura F.6.) va depista erorile din toate fisierele Office.
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Optiuni feedback cliert., ., Figura F.6.

Despre Microsoft Office \Word |
Figura F.5.

Daca doriti sa participati la programul de Tmbunatatire a experientei clientilor atunci puteti
seta optiunile acestui serviciu apeland optiunea Optiuni feedback client.

Apasarea pe tasta functionald F1 produce aparitia ferestrei de ajutor (Figura F.7) (exemplul
este dat pentru Word, dar si celelalte functioneaza la fel).

Dupa cum se poate vedea sunt disponibile o multime de optiuni, printre acestea si optiunea
clasica reprezentata de ,manualul” corespunzator fiecarei componente Office pe care 1l
puteti utiliza in doua moduri:

e urmarirea informatiei dorite in cuprins (selectand icoana @ <UFfins ) |
Cautare pentru:

e cautarea dupa cuvinte cheie (in campul | a ).
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Figura F.7.
in cuprins se observa ca datele sunt structurate intr-o forma arborescenta, pe grupe de
actiuni, ceea ce face ca invatarea si documentarea sa fie usoara. Se vor regasi astfel toate
etapele generarii si redactarii unui document.

3. Microsoft Word 2003

3.1 Deschiderea unui document

Dupa lansare, Word se deschide cu o pagina de document goala (Figura F.8.). Un document
nou se deschide si daca in timpul unei sesiuni de lucru Word se alege secventa

Fisier/Nou..., respectiv se apasa butonul 07 de pe bara de instrumente de lucru.
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Figura F.8.
Fereastra noua Word prezinta in partea dreapta panoul de activitate care se poate activa
bifand optiunea corespunzatoare din meniul Vizualizare (sau prin succesiunea de taste Ctrl
si F1). Aici se pot observa doua sectiuni: Nou si Sabloane. Daca alegeti optiunea Din
document existent se va deschide folderul MyDocuments de unde puteti alege un document,
sau puteti naviga in alte foldere in cautarea documentului dorit.
Daca exista documente care trebuie editate, Word se poate deschide prin dublu click pe
numele figierelor respective si va afiga la deschidere continutul deja existent in ele. Altfel,
daca Word este deja deschis si se doreste sa se lucreze si la alte figiere, deja existente, ele
se deschid cu Fisier/Deschidere... sau prin apasare pe butonul ,iZ“ de pe bara de
instrumente. Se va deschide o fereastra in care in partea stdnga se vor regasi locatiile in
care utilizatorul poate sa caute un document anume. Acestea sunt. Documentele mele
recente (o lista a ultimelor documente accesate de catre utilizator), Spatiu de lucru (desktop-
ul), Documentele mele (folderul MyDocuments), Computerul meu (puteti accesa orice
document aflat pe computerul dumneavoastra), Amplaséri in refea (documente din reteaua
locala, daca exista una).
Se observa ca in Word se pot deschide fisiere de formate diverse, nu neaparat create cu
Word. Tn fereastra de deschidere se pot vizualiza prin derularea listei ,Fisiere de tip:” toate
extensiile recunoscute de Word.
In Word pot fi deschise simultan un numar mare de documente, se pot copia fragmente de
text sau alte obiecte din unul in altul prin intermediul clipboard-ului (asa cum a fost descris Tn
capitolele precedente referitoare la Notepad si WordPad). Gestionarea documentelor
multiple se realizeaza cu ajutorul meniului Fereastra.
Atentie: deschiderea de documente multiple, desi suportatda pana la o anumita limita,
incetineste vizibil functionarea aplicatiei, mai ales in cazul documentelor mari, cu formatari
complicate sau cu multe obiecte inserate (imagini, formule, foi de calcul etc.). Este indicat sa
se salveze periodic, cu grija, continutul documentelor deschise si sa se inchida cele de care
nu mai este nevoie in sesiunea curenta pentru a se preveni pierderea de date prin inchideri
accidentale.

Tn foaia de lucru Word poate fi folosit butonul din dreapta al mouse-ului. In functie de locul
unde este apelat si de entitatile selectate se va deschide o lista de comenzi gi optiuni
contextuala.



3.2 Bara de instrumente

Pe bara de instrumente de lucru se regasesc icoane care reprezintd scurtaturi la toate
comenzile si setarile din meniuri. Poate fi configurata din Vizualizare/Bare de Instrumente,
lista care se deschide astfel prezentdnd diverse grupe de scurtaturi si optiunea
Particularizare.... Particularizarea se poate face si din meniul Instrumente. Particularizarea
se poate face atat la nivelul barelor de instrumente (prin selectarea uneia dintre acestea sunt
aduse simultan mai multe butoane, comune unei anumite actiuni, de exemplu Tabele gi
borduri, Imagine, Desen, etc.), cat si la nivelul comenzilor individuale care pot fi selectate din
listele de comenzi grupate pe meniuri.

Prin stationarea cursorului (fara a se face click) deasupra butoanelor, Word afigeaza intr-un
mic dreptunghi galben semnificatia butonului respectiv. Este astfel usor sa se identifice
comenzile care sunt Tn spatele acestor scurtaturi. Exemplul clasic este butonul care

reprezinta o discheta (,, e "), si care Inseamna intotdeauna Fisier/Salvare.

Bara de instrumente contine scurtaturi la comenzi de uz general (deschidere document nou,
deschidere document existent, salvare etc.) si de formatare a textului in timpul lucrului. Toate
aceste comenzi au corespondent in meniuri.

3.3 Deplasarea in figier

Cursorul marcheaza inceputul documentului, unde utilizatorul poate incepe sa introduca date
(text, imagini, ecuatii etc.). Pe masura ce se introduce textul, randurile se completeaza in
cadrul aceluiasi paragraf. Daca se doreste inceperea unui paragraf nou se apasa tasta
Enter.

Deplasarea in cadrul textului scris se face cu sagetile de pe tastatura, respectiv cu mouse-ul
(se face click cu butonul din stdnga acolo unde se doreste editarea textului introdus).
Deplasarea rapida se face in mai multe moduri:
e cu tasta Home se deplaseaza cursorul la inceputul liniei curente,
cu tasta End se deplaseaza cursorul la sfarsitul liniei curente,
combinatia de taste Ctrl+Home deplaseaza cursorul la inceputul documentului,
combinatia de taste Ctrl+End deplaseaza cursorul la sfarsitul documentului,
cu ajutorul barelor de defilare (,scroll”) orizontale si verticale se poate vedea orice
portiune a documentului fara a se deplasa cursorul in zona respectiva. Deplasarea
cursorului se va face cu click pe butonul stanga al mouse-ului,
e pentru a reveni la locul ultimei editari, chiar si daca intre timp ati inchis figierul si acul
il deschideti din nou, apasati simultan tastele Shift si F5.

3.4 Selectarea textului

Selectarea unui bloc de text se poate face in mai multe moduri:
e se deplaseaza cursorul la inceputul blocului de text, se apasa butonul din stanga al
mouse-ului si se deplaseaza mouse-ul pana cand intregul bloc este evidentiat.
e pentru a selecta tot documentul se apasa Ctrl+A sau se alege din meniul Editare
comanda Selectare Totala.

Pentru a anula o selectie se face click cu mouse-ul oriunde pe ecran.



3.5 Copierea textului

Existd mai multe metode pentru a copia un text. in toate situatiile se parcurg urmatoarele

etape:
[ ]

se selecteaza textul care trebuie copiat,
se alege din meniul Editare comanda Copiere sau se apasa combinatia de taste

Ctrl+C sau butonul /=2 din bara de instrumente, respectiv se face click cu butonul din
dreapta al mouse-ului si se selecteaza Copiere din meniul care apare,

se muta cursorul in noua pozitie,

se alege din meniul Editare comanda Lipire sau se apasa combinatia de taste Ctrl+V

sau butonul & din bara de instrumente, respectiv se face click cu butonul din
dreapta al mouse-ului si se selecteaza Lipire din meniul care apare. in momentul in
care se face lipirea, pe ecran apare o icoana tip Smart Tag care permite selectarea
modului de lipire (Figura F.9.), prin marcarea unei optiuni din lista care apare.

B -

Se pastreaza formatarea sursei

(| Patrivire formatare destinatje

Se paskreazd numai textul

I,_
Al Se aplics stilul sau Formatarea, ..

Figura F.9.

3.6 Mutarea textului

Se procedeaza dupa cum urmeaza:

se selecteaza textul care trebuie mutat,

se alege din meniul Editare comanda Decupare sau se apasa combinatia de taste
Ctrl+X sau butonul ,,c“ﬂ”din bara cu instrumente de lucru. Textul va disparea din
pozitia initiala, dar se va pastra in clipboard.

se muta cursorul in noua pozitie in text,

se alege din meniul Editare comanda Lipire sau se apasa combinatia de taste Ctrl+V

sau butonul ' din bara de instrumente.



3.7 Stergerea textului

Se pot sterge atat caracter cu caracter, cat si blocuri mari de text. Se procedeaza astfel:

e pentru a sterge caracterul din dreapta cursorului, se apasa tasta Delete (Del) de pe
tastatura;

e pentru a sterge caracterul din stdnga cursorului, se apasa tasta Backspace de pe
tastatura;

e pentru a sterge un bloc de text, se selecteaza mai intai blocul respectiv si apoi se
apasa tastele Backspace sau Delete. Aceste actiuni nu pastreaza textul sters in
clipboard.

e stergerea unui bloc de text selectat se face si apasand butonul ,&” din bara de
instrumente sau urmand selectia Editare/Decupare, respectiv Ctrl+X, cu pastrarea
textului in clipboard.

Daca s-a sters din greseala ceva util, textul sters se poate recupera utilizdnd butonul de

anulare 1 7 de pe bara de instrumente, respectiv se alege optiunea Anulare... (Ctrl+Z) din
meniul Editare. Textul sters va fi reamplasat in pozitia initiala.

3.8 Formatarea textului

Posibilitatile de lucru cu Word sunt mult extinse fata de editoarele de text simple care se
instaleaza o data cu Windows XP (Notepad, WordPad). Formatarea textului se refera la
prelucrari de text in ceea ce priveste aspectul (font, marimea, tipul, culoarea etc.) si
asezarea in pagina (alinieri, indentari etc.). Optiunile de formatare se gasesc in meniul
Format, grupate dupa functiuni, iar cele mai utilizate au scurtaturi pe bara de instrumente:

e apelarea tabletei de stiluri si formatari, ’ﬂ,

e definire stil din lista,  “oPEtet iz

« definire font (corp de liters) din lista, ** 5

e definire dimensiune caracter din lista, I & ,
e corp de text aldin (bold), B,

e corp de text cursiv (italic), £,

e corp de text subliniat (underlined),

e textaliniatla stanga —
e text centrat,=

e textaliniat la dreapt
o textaliniat sila stanga Si Ia dreapta, =,

e spatiu intre randuri, - ,
=

e paragraf numerotat, =
e paragraf evidentiat cu semne speciale, i= ,
e micsorare indentare (deplasare subparagraf la stanga), | =

¢ marire indentare (deplasare subparagraf la dreapta), . ,
e bordura exterioara, din lista, .,

e evidentiere text cu culoare, selectie din lista, |ag’? .,
e culoare font, selectie din tableta, i

Pentru formatare se procedeaza astfel:
e se selecteaza textul care trebuie formatat,
e se apasa butonul din bara de instrumente sau se alege optiunea dorita din meniul
Format (se observa ca textul selectat se modifica instantaneu).



Pentru renuntarea la o formatare de genul celor selectabile prin buton, se selecteaza textul si
se dezactiveaza butonul respectiv.

3.9 Inserare de tabele in document

Tabelele din Word permit organizarea textului sub forma de linii i coloane. Fiecare casuta
dintr-un tabel poate contine orice fel de date.

Pentru a crea un tabel intr-un document se parcurg urmatoarele etape:
e se plaseaza cursorul acolo unde trebuie introdus tabelul,
e se selecteaza Tabel/Inserare/Tabel si se aleg optiunile de format dorite in fereastra
aparuta,
e se apasa ,,OK” daca se doreste inserarea tabelului, respectiv ,Revocare” daca nu se
mai doreste acest lucru.

Pentru a se adauga chenar unui tabel, se plaseaza cursorul oriunde in interiorul tabelului si
se deschide meniul Format/Borduri si umbrire..., sau se apasa pe butonul din dreapta al
mouse-ului si se alege Borduri si umbrire.... Apare o fereastra in care se pot defini formele
chenarelor si bordurilor, culori, umbriri etc.

Pentru inserarea de text intr-o celula a tabelului se da click in interiorul ei si se introduce
textul in pozitia cursorului. Continutul uneia sau mai multor celule se poate sterge, muta sau
copia ca orice text, in modul descris mai sus.

Pentru a sterge linii si coloane se selecteaza entitatile respective (sau o celula care face
parte din entitatea respectiva) si din meniul Tabel sau din meniul derulant care apare cand
se da click dreapta cu mouse-ul se alege Stergere si mai departe Coloane, Randuri sau
Celule...(daca se selecteaza optiunea Tabel, intregul tabel va fi sters).

Pentru a insera o linie sau o coloana, se plaseaza cursorul intr-o celula adiacenta locului in
care se doreste adaugarea coloanei, respectiv liniei, se deschide Tabel si se selecteaza
Inserare..., cu optiunile dorite (coloana la stdnga sau la dreapta, rdnd deasupra sau
dedesubt).

Redimensionarea tabelului se face prin deplasarea jaloanelor specifice de pe rigla gradata
care apare sub bara de instrumente. Pentru modificarea coloanelor, exista posibilitatea
scindarii (meniul Tabel->Scindare celule sau butonul H din tabela Tabele si borduri, vezi

Figura F.10.), respectiv imbinarii celulelor (meniul Tabel->imbinare celule sau butonul 1 din
tabela Tabele si borduri).

Tabele si borduri

Al — = »e

Z - [E] & -

d - o (S| g O AR 2) &l =
Figura F.10.

3.10 Alte obiecte care se pot insera in document

Meniul Inserare cuprinde toate comenzile de inserare de obiecte, respectiv de marcatori,
care se pot efectua intr-un document. Dintre acestea, cele mai uzuale sunt:

e inserarea de imagini, Inserare/Imagine..., dupa care se specifica sursa. Peste aceste
imagini se pot realiza evidentieri prin Tncercuire, marcari, indicatii cu sau fara text
chiar in documentul Word, mai simple, utilizand instrumentele de desenare aflate la
baza ferestrei de lucru (Figura F.11.). Pentru formatari la nivel de imagine, se
selecteaza imaginea respectiva cu butonul din dreapta al mouse-ului si se alege
Formatare imagine... din lista, dupa care in fereastra care se deschide se fac toate
setarile.

e inserarea de hyperlink-uri se face apeland succesiunea Inserare->Hyperlink... sau
combinatia de taste Cirl si K. Se deschide o fereastra in care se defineste legatura,
care poate face referire la pasaje din documentul curent sau la alte documente.



Editarea sau indepartarea acestor tipuri de legaturi se face in cadrul optiunii
Hyperlink din meniul Inserare. Prin hyperlink-uri se realizeaza salturi in cadrul
documentului sau dintr-un document n altul.

inserarea de simboluri, Inserare->Simbol.... Se deschide un tabel multiplu cu
simboluri (de exemplu, litere grecesti, simbolul EURO, grad Celsius etc.) care se pot
introduce in text in pozitia cursorului prin apasarea butonului Inserare. Se observa ca
exista o lista de fonturi posibile. Simbolurile se regasesc si ca subseturi, astfel ele pot
fi gasite mai usor de catre utilizator.

inserarea de formule matematice, Inserare/Cémp.... Din listd se pot alege entitati
multiple, de exemplu Formula (pentru realizarea de operatii matematice), Eq (pentru
editarea de ecuatii matematice cu operatii $i simboluri specifice) etc.

inserare de obiecte diverse, Inserare/Obiect.... Obiectele pot fi: tabele Excel, grafice,
diagrame Access, calendar, capturi de ecran etc.

o optiune importantd din meniul Inserare este Referintd de unde puteti alege
introducerea notelor de subsol, a legendelor pentru figuri, referintelor si a diferite
tabele, inclusiv a unui cuprins care va fi completat automat, daca numele capitolelor
au fost definite ca titluri din tableta de stiluri.

inserarea de salturi de pagina, numerotari, data si ora curenta etc.

Egesenare* L |Fgrmeautcumate* S [0 A -u/‘ui':.f @ fﬂl&'ﬁ'&'E e E o Ij!

Figura F.11.

3.11 Alte formatari in document

Meniul Format cuprinde formatari referitoare la toate tipurile de entitati din document.
Acestea pot fi aplicate intregului document sau portiunilor selectate. Formatarile cele mai
uzuale (din care o parte se gasesc si pe bara de instrumente) sunt, in linii mari, urmatoarele:

Format->Font... deschide o fereastra de dialog in care se definesc caracteristicile
corpului de litera folosit in document sau pe portiunile selectate. Permite selectarea
tipului de caracter, a marimii, stilului, efectelor si contine o fereastra in care se va
vedea efectul setarilor facute inainte ca ele sa fie aplicate in document.
Format->Paragraf... deschide o fereastra in care se definesc caracteristicile
paragrafului selectat: aliniere, spatiere, indentare etc., cu posibilitatea de a vizualiza
efectul setarilor inainte de a fi aplicate in document.

Format->Marcatori si numerotare... deschide fereastra de realizare a titlurilor de
paragraf si indentarilor in text.

Format->Coloane ofera posibilitatea scrierii textului pe coloane in pagina, fara a se
defini tabele.

Format->Modificare dupa caz oferad posibilitatea de a trece de la majuscule la litere mici,
conform nevoilor utilizatorului:

Modificare majuscule/minuscule '|

{:} Caz propozikie,
) minuscule

) Caz kith
() cAZ cOMUTARE

[ 04 l [ Rewvocare

Figura F.12.
alte formatari: tabulatori, fundalul paginii etc.

Un alt mod de a se realiza formatari de corpuri de text selectate este prin actionarea
marcatorilor de indentare de pe rigla gradata care apare deasupra documentului. Pozitia
acestora defineste pozitia inceputului de paragraf fata de marginea din stanga a formatului,
pozitia corpului textului aliniat fatd de marginile documentului etc.



3.12 Formatarea paginii

Definirea portiunii tiparite din foaia alba se face prin deschiderea ferestrei Fisier/
Initializare_pagina... (Figura F.13).

Se definesc marginile documentului, pozitia formatului (tip portret, vertical, respectiv tip
vedere, orizontal). Unitatle de masura se stabilesc in [Instrumente/Optiuni/General.
Dimensiunea paginii de document se alege din fila Hartie (Figura F.14) si este recomandabil
sa fie un format recunoscut de imprimanta, iar hartia utilizatd pentru tiparire sa aiba chiar
acel format, pentru a evita orice eroare.

Initializare pagina Initializare pagina

Fila a treia defineste aspectul general al paginii, spatiul rezervat antetului gi subsolului

etc.(Figura F.15).

Matgini | Hértie Aspect Margini | HArtie Aspect
Margini Dimensiune harkie:
Stinge: Dreapta Lo ~
. = = - Skakement =
Pt indoire: Pogitie indoitur: Executive
A3
Crientare i
Prima paging: Celelalte pagini:
Tava implicita {Automatically Tava implicita {Automatically
Tip partret Tipvedere Automatically Select 3 Automatically Select 3
Panini Tray 1 3 Tray 1 =
a Tray 2 Tray 2
Pagini multiple: |N0rma| v Tray 3 Tray 3
Tray 4 b’ Tray 4 b
Examinare Examinare
Se aplicd pentru: —_— Se aplica pentru: —
Document intreg w — | Document intreg v | —_—
_ Optiuni de imprimare, ., p—]
Irnplicit. .. l [o] 4 ] [ Revocars Iraplicit... [ Ok ] [ Revocare
Figura F.13. Figura F.14.




Initializare pagina

Margini | Hartie
Sectiune

Inceput seckiune: Paging noud it

Anketuri si subsoluri
[] ragina pars difers de cea impar
[] prima paging diferics

De la muchie; anket: |1 cm

LR R

Subsol: |1 ecm

Pagini

<

Aliniere werticald: Sus

Examinare

S aplicd pentru;

Document inkreg w

[ﬁumere de linie. .. ] [ Borduri. .. ]

[ (814 ] [ Rewocare
Figura F.15.

3.13 Vizualizarea documentului

Atat Tn timpul lucrului, cat si Tnaintea tiparirii, este necesar sa se controleze redactarea
documentului din punct de vedere al aspectului sau. In acest sens se folosesc optiunile
meniului Vizualizare. Astfel, documentul se poate vedea in fereastra de lucru in mai multe
moduri:
e Normal, vizualizarea implicita,
o Aspect pagind Web, pentru a se vizualiza in conditii de Web un document care se
redacteaza pentru a se salva ,.htm” sau ,.html”.
o Aspect pagina imprimata, in care se vede si ,hartia” de sub text,
e Antet si subsol, in care corpul documentului se vede cenusiu deschis si nu este
accesibil, in timp ce sunt deschise pentru editare antetul si subsolul.
e Schita, pentru organizarea si structurarea continutului figierului.

Panoramarea documentului se poate face si prin selectarea scarii de reprezentare din lista
aflata in bara de instrumente rapide, « !'"% =

O forma de vizualizare foarte importanta este Fisier->Examinare inaintea imprimadrii (butonul

Ko ), care va afigsa pe ecran aspectul tiparit al documentului. lesirea din pagina de examinare
se face apasand butonul Inchidere de pe bara de instrumente. Atentie: aceasta verificare se
face obligatoriu Tnaintea oricarei tipariri la imprimanta.

3.14 Alte instrumente de lucru
In meniul Instrumente se gasesc, in afara posibilitdti de particularizare a barei de
instrumente, si alte aplicatii utile pentru lucrul in Word, printre care:

e corectarea automata ortografica si gramaticala a textului introdus, se poate declansa

si prin apasarea tastei functionale F7 sau a butonului ?. Corectura instantanee, in
timpul lucrului, se defineste, de regula, inainte de inceperea editarii documentului

¢ elemente referitoare la limba: stabilirea limbii curente de lucru, traducere, lexicon de
termeni, despartiri in silabe.



optiuni de protejare a documentului prin selectarea optiunii Protejare document, unde
puteti defini diferite drepturi pentru ceilalti utilizatori din cadrul sistemului cu privire la
restrictiile la formatare, editare si la pornire. Pentru introducerea de parole in meniul
Instrumente, selectati Optiuni si aici, in fila Securitate, puteti crea o parola pentru
deschidere (sectiunea Parold pentru deschidere) sau o parola pentru modificare
(sectiunea Parola pentru modificare). Se recomanda folosirea de parole puternice,
combinatii de litere mari gi mici, numere si simboluri. Pentru crearea de parole lungi,
pana la 255 de caractere, dati click pe butonul Complex, apoi selectati un tip de
codare RC4. La inchiderea filei, prin apasarea butonului OK, vi se va cere sa
confirmati parola.

fereastra Optiuni, care se refera la functionarea generala a aplicatiei Word si cuprinde
o multitudine de file cu liste de setari grupate dupa destinatie si actiune (editare,
salvare, compatibilitati, corecturi, marcare modificari recente etc.). Majoritatea acestor
optiuni o data stabilite se aplica tuturor sesiunilor de lucru Word lansate, pana la noi
modificari.

Foarte utile sunt si localizarile rapide de termeni in text, respectiv inlocuirile. Acestea se fac
din fereastra de Gasire si inlocuire care se deschide prin selectarea oricareia dintre optiunile:

Gasire (42, inlocuire (), Salt la...(*), din meniul Editare, respectiv prin comenzile:

Editare->Gasire... (Ctrl+F) (Figura F.16.),

Gasire i nlocuire

Gasire | Inlocuire | Saltla

De cautat: word A

Evidentierea elementelor gasite in:

Document principal i Mai pukin £ ] [Gési[ea tuturor] [ Fevocare

Opkiuni cautare

|:| Potrivire litere mari si mici

|:| Mumai cuvinke compleke

|:| LUtilizare metacaractere

[] Pronuntie apropiats {englez3)

[[] se gésesc toate formele cuv&nkului (engleza)
Gasire

[ Faormat = HSpgciaIé* ]

Figura F.16.

Editare->Inlocuire... (Ctrl+H) (Figura F.17),



Gasire §i Tnlocuire

Gasire | Inlocuive | Salk |a

De cAutat: |wnrd w |

Cpkiuni;  CAukare in jos

Inlocuire cu: |cuv§nt| w |

[Mgi putin % ] [ Tnlocuire ] [Tﬂlocuire peste tnt] [Llrmétnrul gésit] [ Revocare ]

Opkiuni cdutare

Cautare;

[ potrivire likere

|:| Mumaj cuvinte complete

|:| Utilizare metacaractere

[] Pronuntie apropiaks (engleza)

[] se gésesc toate formele cuvantului (englezs)
Trlocuire

’ Farmat - ][Spe_cialé- ]

Figura F.17.

e Editare->Salt la... (Ctrl+G), (Figura F.18).

Gasire gi Tnlocuire

Gasire fnl_cu:uire| Salt la |

De sarit la: Introduceti numarul de pagina:
~ 10
Sectiune 3
Linie CU + 5i - w8 puteti deplasa Fatd de amplasarea
Marcaj in document — curenta, De exemplu; +4 & mukd cu patru
Comentariu elerente inainte.
hokd de subsal
hoka de final b =
= I Salk la ] [ Inchidere

Figura F.18.

3.15 Salvarea documentelor

Salvarea documentelor se face in mai multe moduri:

e prin selectarea Fisier->Salvare, respectiv Ctrl+S sau butonul = de pe bara de
instrumente, se utilizeaza atunci cand fisierul care este salvat a fost editat in
sesiunea curentd, salvdndu-se cu acelasi nume, in aceeasi locatie si cu aceeasi
extensie.

e prin selectarea Figier->Salvare ca..., atunci cand fisierul a fost creat in sesiunea
curenta si nu are nume atribuit de utilizator, respectiv atunci cand fisierul se salveaza
cu alt nume, cu alt tip (alta extensie din lista care se deruleaza sub eticheta Tip figier)
sau in alta locatie.

3.16 Imprimarea documentelor

Documentul curent se poate tipari (imprima) prin selectarea comenzii Fisier->Imprimare...,

sau apasarea simultana a tastelor Ctr/ si P, respectiv apasarea butonului 3 de pe bara de
instrumente. Este bina ca inainte de imprimare paginile sa fie examinate, pentru a se vedea
daca setarile facute corespund. In toate situatiile va aparea fereastra din Figura F.19.



Imprimare

Imprimanta
Tdurme: iz InfoPrint 32 A Proprietati
Stare: Inackiv _
Tip: IEM InfoPrint 32
Unde: wis_a_vis [ tmprimare in fisier
Carmentariu: I:l Duplex manual
Sir de pagini Copii
() Toate Mumar de copii: 3
() Pagina curentd 1 1
) Pagini: H’ H‘ asamblare
Introduceti numere de paging gifsau siruri de pagini
separate prin virgule, De ex.: 1,3,5-12
Panoramare
De imprimat: | Document
) Pagini per foaie: 1 paging L¥3
Imprimare: Taoate paginile din interval
Scalare la dim. hartie: | Fara scalare »
o] [reveeme
Figura F.19.

Word detecteaza automat imprimanta activa in sistem. Daca sunt instalate mai multe
imprimante si se doreste alta decat cea implicita, se alege din lista (Nume:). Se definesc apoi
cerintele de tiparire: care pagini se tiparesc, cate exemplare etc. Orientarea hartiei (portret,
vedere) si locul din care se extrage (sertarul de imprimanta care contine coli de formatul
specificat in Figier->Initializare pagind) se pot defini prin apasarea butonului Proprietati.
Optiunile de imprimare se pot seta din fereastra ce rezulta prin apasarea butonului Optiuni...,
sau din Instrumente->Optiuni->Imprimare (Figura F.20.).

Optiuni
Corectare ortograficd & gramaticald Irm&rire modificari Informatii utilizator
Compatibilitate Amplasare fisiere
Yizualizare zeneral Editare Imprimare Salvare SECUritate

Optiuni de imprimare

|:| ; Imprimare in fundal
[ ackw: mpLr [] Imprimare PostScript peste kext
[ actuslizare legakuri [ 1rwersare ordine de imprimare

Se permite redimensionarea hartisi A4jiLetter

Includere cu documentul

[ eroprietati document [ Text ascuns
[ coduri de cimp CObiecte desenate
[ Etichete xpL [ culati 5i imagini de Fundal

Optiuni numai pentru documentul curent
[] 5e imprim& doar datele din machete

Tava implicitd: | Se utilizeazd setérile imprimantei

Optiuni pentru imprimare duples:
[ Fata foii [] spatele Foii

N3

[ OF ] [ Revocare

Figura F.20.

3.17 Alte caracteristici functionale

O trasatura specifica acestei versiuni de Word este Cercetare cu ajutorul careia utilizatorul
poate introduce cu usurinta, fara sa paraseasca programul Office, definitii, cotatii la bursa si
alte informatii. Aceasta optiune este initializata selectand Cercetare din meniul Instrumente,

apasand butonul S de pe bara de instrumente sau prin combinatia Alt+Click. Selectati



textul asupra caruia doriti sa efectuati o cercetare si apasati butonul ESY . In partea dreapta
va fi afigat panoul continand rezultatele cautarii.

: Cercetare ¥ W

CAutare dupa:

|I:uara |
|Tuate carkile de referinkd “ |

=l Lexicon: Romana
(Romania)

inhiba {n.)
fereca (n.)

curma {n.)

inchide {n.})

atine {n.)

anula {n.}

=l Cuvinte associate
bard in.)

+ Traducere

4l Mu gasiti?

0 Cbkineti actualizari ale servicilar. ..
D;a Cbkineti servidi in Bazarul Office

:-L-IL optiuni cercetare. ..

Figura F.21.
Daca doriti largirea zonei de cautare, selectati Optiuni de cercetare. Se va deschide fereastra
din Figura F.22 in care puteti bifa mai multe servicii de cautare, adauga sau indeparta
Servicii.
Tot aici puteti seta filtrarea continutului potential ofensator, dand click pe butonul Control
parental cand puteti seta si o parola pentru a impiedica modificarea setarilor de catre alti
utilizatori.



Optiuni cercetare

Pentru a activa un serviciu pentru caukare, selectati caseta de selectare asociabd cu serviciul,

Servicii:

Carki de referinta
Encarta Dictionary: Enaleza (America de Mord)

[] Encarta Dictionary: Englez3 (Regatul Unit)

|:| Encarta Dictionary: Franceza
[] Lexicon: Englez3 (Australia)
Lexicon: Engleza (Marea Brikanie) b
[] Lexicon: Englez3 {5.U.4.5
[] Lexicon: Francezs (Canada)
Lexicon: Franceza (Franta)
Lexicon: Fomana (Romania)
Lexicon: Spaniol3 (Spania-Sortare modernd)
Traducere
Situri de cercetare

elibrary

[l Frrarta Frcvdonedias Froless Camerica de Bioed \:
[ Adaugare servici. .. ] [ Actualizare/Elminare. .. ] [ Control parental ]
[ Ok, I ’ Revocare ]
Figura F.22.

Puteti initia o cautare de figiere fara a parasi aplicatia Word: in meniul Figier selectati

optiunea Céutare figiere sau apasati butonul 2 de pe bara de instrumente. in partea
dreapta a ferestrei Word se va deschide panoul Cautare de baza fisiere din figura F.23.

Cautare de baza fisiere e

Cautare dupa:

CAutare text:

|

gl SFaturi cautare...

Alte optiuni de cautare:

Caukare in:

|.¢\mpla55rile selectate W |

Rezultatele trebuie 55 fie:

|Ti|:|uri de fisiere selectate W |

CAutarea rapidd este in prezent
dezactivati

Opkiuni cautare. ..

¥Yedeti si

(:l Cautare complexa figiere
iﬂb Cercetare

#4 Gasire in acest document, .,



Figura F.23

In caseta Cautare text introduceti unul sau mai multe cuvinte. Vor fi returnate fisierele care
contin aceste cuvinte, fie ca ele se afla in corpul figierului, in cuvintele cheie sau in alte
proprietati ale fisierului. Vor fi luate in consideratie diferitele forme ale cuvintelor dupa care
se face cautarea. De asemenea, puteti folosi metacaractere atunci cand introduceti textul de
cautat: asteriscul (*) tine locul unui grup de unul sau mai multe caractere, semnul intrebarii
(?) tine locul unui singur caracter.
Daca folositi serviciul de indexare (cautare rapida) utilizarea metacaracterelor este acceptata
numai pentru cautarea numelor de figiere.
in caseta Cautare in trebuie specificat locul in care doriti s& se efectueze cdutarea. Daca stiti
folderul in care doriti sa realizati aceasta cautarea introduceti calea catre respectivul folder,
daca nu alegeti din optiunile puse la dispozitie in meniul derulant: My Computer, Amplasari
in retea, Outlook. Dati click pe semnul plus (+) de langa numele folderului respectiv pentru a
vizualiza sub-folderele sale. Selectati folderele n care doriti efectuarea cautarii.
In caseta Rezultatele trebuie s& fie selectati tipurile de figiere de gasit. Acestea vor fi
selectate din lista care se deruleaza la apasarea butonului_¥! din extremitatea dreapta a
campului.
in sectiunea Vedeti gi selectand optiunea Cautare complexé fisiere veti putea seta diferite
limitari valorii unei proprietati a unui figier astfel incat cautarea va deveni mai specifica.
Fiecare tip de proprietate (care poate fi selectata din lista care apare in caseta Proprietate)
are un set de conditii relevante afigate automat de cautarea complexa, utilizatorul avand
posibilitatea de a alege una pentru a configura cautarea. Exemple de conditii:

e Conditii pentru proprietati de tip text

o] este: textul proprietatii se potriveste exact cu valoarea cautata
o] include: textul proprietatii contine valoarea cautata
e Conditii pentru proprietati de tip data
o] pe: data se potriveste cu valoarea specificata
o] pe sau dupa: data se potriveste sau se afla dupa valoarea specificata
o] pe sau inainte: data se potriveste sau se afla inaintea valorii specificate
o] astazi: data se potriveste datei curente
o] maine: data se potriveste datei de maine
o] ieri: data se potriveste datei de ieri
o] saptamana aceasta: data este candva saptamana aceasta
o] saptamana viitoare: data este candva saptamana viitoare
o] saptamana trecuta: data a fost cAndva saptamana trecuta
o] luna aceasta: data a fost cAndva luna aceasta
o] luna viitoare: data este candva luna viitoare
o] luna trecuta: data a fost candva luna trecuta
e Conditii pentru numele figierelor
o] include: numele fisierului include sau este exact textul specificat
e Conditii pentru proprietati numerice
o] egal cu: se potriveste exact valorii specificate
o] nu este egal cu: nu se potriveste valorii specificate
o] mai mare decéat: este mai mare decat valoarea specificata
o] mai mic decat: este mai mic decat valoarea specificata
o] cel putin: se potriveste sau depageste valoarea specificata
o] cel mult: se potrivegte sau este mai putin decét valoarea specificata
o Conditii pentru proprietati de tip Da/Nu
o] este da
0] este nu
e Conditii pentru proprietati senzitive
o] egal cu Minim: are valoarea Minim (,/Importanta egal cu Minim”)
o] egal cu Normal: are valoarea Normal
o] egal cu Maxim: are valoarea Maxim
o] nu este egal cu Minim: nu are valoarea Minim
o] nu este egal cu Normal: nu are valoarea Normal
o] nu este egal cu Maxim: nu are valoarea Maxim



o Conditii pentru proprietati de stare
o] egal cu Nu s-a pornit: are valoarea Nu s-a pornit

egal cu in curs: are valoarea In curs

egal cu Terminat: are valoarea Terminat

egal cu In asteptarea altcuiva: are valoarea /n asteptarea altcuiva

egal cu Amanat: are valoarea Aménat

nu este egal cu Nu s-a pornit: nu are valoarea Nu s-a pornit

nu este egal cu in curs: nu are valoarea in curs

nu este egal cu Terminat: nu are valoarea Terminat

nu este egal cu in asteptarea altcuiva: nu are valoarea In asteptarea
altcuiva

o] nu este egal cu Amanat: nu are valoarea Amanat

Tot in sectiunea Vedeli si se mai regasesc alte doua optiuni: Cercetare gi Gasire in acest
document.
Proprietatile unui document pot fi setate pentru figierul activ in orice aplicatie Microsoft
selectand din meniul Figier optiunea Proprietati. Este afisata fereastra din Figura F.24.

F_OfficeXP.doc Proprietati

OO0OO0OO0OO0OO0O0O0

ERezumat Statisticd || Cuprins | Particularizare

@ j F_CifficesP,doc

Tip: Microsoft Word 97-2003 Document
amplasare:  DiproiectelMECOH, Carte
Dimensiune:  2,93M0 (3,125,248 ocketj)

Mume M5-DO05: F_OFFI~1,00C

Creat; Z& augusk 2005 11:09:24
Modificat: 24 august 2005 12:41:46
Accesat: 24 augusk 2005 12:41:46
Akribute:
[ QK ] [ Revocare ]
Figura F.24.

Cele cinci file disponibile (General, Rezumat, Statistica, Cuprins si Particularizare) includ
patru tipuri de proprietati: proprietati actualizate automat care includ date statistice pastrate
de aplicatile Microsoft, cum ar fi: dimensiunea figierului, data crearii si ultimei modificari a
acestuia, etc.; proprietati stabilite care exista deja, dar care se recomanda a fi completate de
catre utilizator pentru o regasire mai facila, cum ar fi Cuvinte cheie din fila Rezumat;
proprietati particularizate (fila Particularizare) care sunt proprietati definite de catre utilizator,
acestora li se poate asocia o valoare de tip text, timp sau de tip numeric, valori da sau nu,
numele lor pot fi preluate din lista asociata casetei Nume sau pot fi definite de catre utilizator,
cu posibilitatea de a le lega de anumite elemente ale documentului, fie ca este vorba de o
celula dintr-un fisier Excel, un element dintr-un figsier PowerPoint sau un marcaj intr-un
document de tip Word (de exemplu, daca se creeaza o proprietate particularizata de tip data
legatd de un camp dintr-un formular de tip contract care contine data de expirare a
contractului, mai tarziu se poate face o cautare dupa contractele care au data de expirare
anterioara sau ulterioara unei date specificate in criterile de cautare dupa proprietati);
proprietatile biblioteca de documente care sunt specifice documentelor dintr-o biblioteca de
documente (de exemplu, proprietati de genul: Propus de, Aprobat de, etc.).



in meniul Vizualizare existd optiunea Aspect citire (butonul SHotre e pe bara de
instrumente) cu ajutorul careia utilizatorul poate vizualiza documentul activ (doar textul, fara,
de exemplu, antet si subsol) si parcurge ecran cu ecran.

o E_Linux.doc - Microsoft Word
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Ecranul 23 din 99 .

Ecranul 24 din 99

6.1.4 Meniul Applications Eile Edit Wiew Places Melp

Acest meniu asigurd un acces usor la ierarhia de aplicatii instalate

in sistem. Cele mai multe sunt grupate in sub-meniuri dedicate an Documerts T
unei categorii ca System, Office si Internet. Pentru a porni o -
aplicatie dati click pe Applications, alegeti categoria doritd,
desfagurati sub-meniul si dati click pe numele aplicatiei. =
Programele care nu sunt in meniu pot fi initiate cu prompt-ul Run
Application (Alt+F2), atunci cénd cunoasteti comanda. De
exemplu, dacd doriti sa vedeti fotografii digitale si nu gasiti
comanda Thumb in meniu, introduceti thumb din prompt-ul Run
Application.

6.1.5 Meniul Places

Eswilber = 3 items, Free space! 6.4 GB
Figura E.3

Acest meniu asiguré un acces comod la locatii precum directorul
home propriu, drive-uri, foldere de desktop si de retea.
6.1.6 Meniul Desktop

Meniul contine comenzile de baza pentru administrarea desktop-
ului. Aici se gasesc Lock Screen si Log Out.

Un folder se deschide dand dublu-click pe el, cdnd va apare o
fereastra care afigeaza continutul acestuia.

Nautilus dispune si de o interfatd de tip browser. Dati click
dreapta pe folder si alegeti Browse Folder. Se va deschide o
noud ferastra Mautilus cu aceleasi functi, dar cu aspect de
browser. Navigarea prin foldere si fisiere se face cu butoanele

6.2 Administarea figierelor cu Nautilus Back (inapoi), Forward (inainte) si Up (sus) la fel ca intr-un
browser de web.
Nautilus este managerul de fisiere din GNOME.
O fereastra standard Nautilus este prezentatd in Figura E.3. Pentru deplasarea intre foldere se foloseste meniul derulant din
coltul stdnga-jos al ferestrei Nautilus. Aici sunt toate folderele
parinti ai directorului curent pana la radacina (root) sistemului de
fisiere. Selectati fisierul dont si el se deschide intr-o fereastra
noud deasupra celel vechi. Directorul parinte al folder-ului curent
se deschide cu File->Open Parent. Dacéd vrefi sa inchideti

directoarele parinte selectati File->Close Parent Folders.

“om(g

Figura F.25
Pe bara de instrumente se pot observa mai multe butoane a caror semnificatie este, in cea

mai mare parte, deja cunoscuti. Selectand Imagini micsorate, 1] Imaginimicsarate g, partea
stdnga a acestei vederi vor fi amplasate paginile documentului mult micsorate:

Figura F.26.
Prin selectarea uneia dintre paginile minimalizate, acestea vor fi afisate pe ecranul principal.
Daca doriti sa se afiseze forma integrala a paginii, atunci dati click pe butonul Pagina

actuala, al,
lesirea din aceasta vedere se face ap&sand butonul -+ Inchidere



Un document poate fi trimis pe email, fara a fi nevoie sa parasiti aplicatia Office. in meniul
Figier, selectati optiune Transmitere cétre..., apoi Destinatar (documentul va fi introdus in
corpul scrisorii) sau Destinatar corespondenta (ca atasare), recomandabil daca se doreste
salvarea documentului ca atare la destinatie. In figura de mai jos se pot observa si celelalte
optiuni de transmitere.

o=jl| Destinatar
w2l Destinatar corespondentd (pentru Revizuire)..,
Destinatar corespondenta (ca atagare). ..

Destinatar in distribuire. ..

Folder Exchange...
Participant |a inkalnirea interackiva
Destinatar atilizénd un modem Fax.. .

Destinatar utilizdnd Serviciul Internet Fax...

B.0Q

Microsaft Office PowerPoink

Figura F.27.




4. Microsoft Excel

4.1 Deschiderea unui registru

Dupa lansare, Excel se deschide cu o pagina de registru gol (Figura F.28). Un registru nou
se deschide si daca in timpul unei sesiuni de lucru Excel se alege secventa Figier->Nou...,

respectiv se apasa butonul J de pe bara de instrumente de lucru.
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Figura F.28

Aici se pot observa doua sectiuni: Nou si Sabloane. Puteti selecta un registru de lucru
necompletat sau sa alegeti optiunea Din registru de lucru existent cand se va deschide
folderul MyDocuments de unde puteti alege un document, sau puteti naviga in alte foldere in
cautarea documentului dorit.

Daca exista registre care trebuie editate, Excel se poate deschide prin dublu click pe numele
fisierelor respective gi va afisa la deschidere continutul deja existent in ele. Altfel, daca Excel
este deja deschis si se doreste sa se lucreze si la alte fisiere, deja existente, ele se deschid

cu Figier/Deschidere... sau prin apasand butonul = de pe bara de instrumente. Se observa
ca in Excel se pot deschide fisiere de formate diverse, nu neaparat create cu Excel (extensia
implicita .xIs). In fereastra de deschidere se pot vizualiza prin derularea listei Fisiere de tip:
toate extensiile recunoscute de Excel.

In Excel pot fi deschise simultan un numéar mare de registre, se pot copia campuri si
fnregistrari din unul Tn altul prin intermediul clipboard-ului (asa cum a fost descris in
capitolele precedente). Gestionarea registrelor multiple se realizeaza cu ajutorul meniului
Fereastra.

Atentie: deschiderea de registre multiple, desi suportata pana la o anumita limita, incetineste
vizibil functionarea aplicatiei, mai ales in cazul registrelor mari, cu formatari complicate sau
cu foi de diagrame si reprezentari grafice. Este indicat sa se salveze periodic, cu grija,
continutul registrelor deschise si sa se inchida cele de care nu mi este nevoie in sesiunea
curenta pentru a se preveni pierderea de date prin inchideri accidentale.



in foaia de lucru Excel poate fi folosit butonul din dreapta al mouse-ului. in functie de locul
unde este apelat si de entitatile selectate se va deschide o lista de comenzi si optiuni
contextuala.

Fisierul curent se salveaza in formatul initial de fisier sau ca registru de lucru Excel prin
utilizarea comenzilor standard de salvare din Excel. Daca este destinat utilizarii in versiuni
anterioare de Excel sau ale altor programe de calcul tabelar, se poate modifica formatul
implicit la salvare cu unul corespunzator, ales din lista. Salvarea se face in aceleasi conditii
ca si in cazul aplicatiei Word.

Daca datele care trebuie utilizate in Excel sunt continute intr-un figier text cu delimitatori
(caractere de separare) gen tabulatori, virgule, spatii sau altele, specificate, in Excel se
poate deschide figierul .txt. Excel utilizeaza optiunea de import date pentru a interpreta textul
in conformitate cu instructiunile primite si imparte datele pe réanduri si coloane pe o foaie de
lucru. Datele text delimitate dintr-un document de procesare de text sau dintr-un alt
document se pot copia intr-un registru de lucru (in secventa Ctr/+C, Ctrl+V), pentru ca apoi
sa se imparta textul in coloane.

La deschiderea registrului de lucru Excel se observa organizarea lui sub forma de tabel, cu
linii marcate prin cifre si coloane marcate prin literele alfabetului latin, si existenta a trei foi de
lucru.

Deplasarea in spatiul de lucru, selectia si stergerea (golirea) functioneaza dupa aceleasi
principii ca in toate celelalte aplicatii sub Windows. Selectia se poate face pe celule sau pe
intregi linii si coloane, prin selectarea butoanelor care le identifica de pe marginea foilor de
lucru. La copiere si mutare puteti opta pentru Lipire Speciala... (Figura F.29). Cu ajutorul ei
se poate alege ce atribute atagate celulelor se copiaza o data cu continutul vizibil selectat,
operatii care se fac la copiere, respectiv mutare, etc.

Lipire speciala

Lipire
{ : () walidare

" Farmul (73 Tat exceptsnd bordurile

(3 Yalari {3 Lakimi coloane

) Eormate () Formule 5 formate de numere

() Comentati ) walori 5i formate de numere
Operatie

{*) Mici una (3 Inmultire

() AdSugare (3 Tmpartire

() scadere

[ 1gnorare celule libere [] Transpuners
[ Lipire cu legatura ] [ (0] 4 ] [ Revocare ]

Figura F.29.

Modul de umplere a celulelor din spatiul de lucru se defineste in Editare->Umplere.

4.2 Formatari in spatiul de lucru

Datele care se introduc in celule pot fi de mai multe tipuri, insotite de diverse atribute.
Definirea acestora se face prin Format->Celule... (Ctrl+1), respectiv click pe butonul din
dreapta al mouse-ului si selectarea Formatare celule.... In toate situatile se deschide o
fereastra cu file multiple, in care setarile sunt grupate dupa functia lor (Figura F.30.).



Formatare celule

Murn&r | aliniere Font Bordurd | Modele | Protectie
Cateqorie: Ezantian

Genetal

Tumar

Simbal monetar Mumar zecimale: -

Conkabil

Data

Or3 [] utilizare separator mii {3

Procenta Mumere negative:

Fractie = 4 '

Stiinkific

Texk 1234,10

Special -1234,10

Particularizat -1234,10
Formatul Mumar este utilizat pentru afisarea generald a numerelor,
Formatele Simbol monetar si Conkabil oferd variante specializate pentru
walorile monetare.

Ok

l

] [ Revocare ]

Figura F.30.

In prima fil& (Numar) se defineste tipul datelor. In exemplul prezentat, datele sunt de tip
numar real, cu doud zecimale dupa virgula. n fila Aliniere se formateaza dispunerea datelor
fatd de marginile celulei, Font guverneaza corpul de litera utilizat gi caracteristicile lui, pot fi
definite borduri si culori, si in Protectie, celula poate fi ascunsa.

Alte optiuni prezente in meniul Format
lucru, stiluri generale in registru, etc.

Particularizarea mediului de lucru Exce
existente in filele ferestrei Instrumente->

Optiuni

se refera la coloane si randuri, respectiv la foaia de

| se face, ca si in Word, prin configurarea optiunilor
Optiuni....

Salvare
Editare

Culoare International

Calcul

‘erificare erori Corectare ortograficd Securitate

General Tranzitie Liste particularizate Diagrama

Afisare

Carnentarii
() Mici unul
Ohbiecte
(¥ Afigare totals
Opkiuni Fereastrd
[] sfrsituri de paging
1 Eormule
Linii de grils yal

Culoare linii de grila:

Panou activitate lansare in executie Bara de Formule Bard de stare Ferestre in bara de activitsti

(%) Doar indicator de comentariu

() Afisare substituente

Anketuri de rand & coloans
Simboluri din schitd

() Comentariu & indicatar

() Ascundere tatals

Bara de defilare pe orizontald
Bard de defilare pe verticald

ori nule Selectori Foi

QK ] [ Rewocare

Figura F.31.



4.3 Calculul tabelar

Excel este o aplicatie de calcul tabelar. Fiecare celula din tabel poate contine date de intrare
de diferite tipuri, introduse de utilizator pe diverse cai (direct, copiat din alte fisiere sau
aplicatii) sau date rezultate in urma unor calcule care pot fi definite prin formule de calcul.

Prin pozitionarea cursorului intr-o celula se deschide automat posibilitatea de a defini datele
din acea celula ca rezultat al unor calcule de diferite feluri (functii matematice, calcule

statistice, operatii logice, etc.), prin apasarea butonului fe de pe bara de instrumente sau
apelarea succesiunii Inserare->Functie..... Se deschide fereastra din Figura F.32, in care
utilizatorul poate selecta o functie care sa fie activa in cdmpul respectiv. in fereastra va gasi
informatii despre acea functie, ce face si la ce se aplica, sintaxa ei (argumentele care trebuie
definite) etc. Puteti vizualiza toate functiile, selectand optiunea Toate din campul Selectati o
categorie, sau functiile asociate unei categorii (Financiare, Datd&Oréa, Mat&Trig, Statistice,
Logice, Text, etc.)

Inserare functie

Se cautd functia:
Taskati o scurt3 descriere a operatiei, apoi Faceti clic pe
Salt

Selectati o cateqarie: | Toate W

Selectati o functie:

T
SUMIF

SUMPRCDUCT

SUMS0)

SUMRZMY2

SUMH2PY2

UMMy v

SUM{number 1;numberz;...)
Aduna toate numerele dinkr-o zona de celule,

Ajutor penkru aceasts functie [ i l [ Revocare ]

Figura F.32.

Prin apasarea butonului OK functia se introduce in celula curentd si Excel deschide o
fereastra specifica pentru definirea argumentelor (Figura F.33).

Argumentele sunt identificatori de celule de forma ,,coloana_linie” (de exemplu, A4 inseamna
coloana A, linia 4) care sunt de fapt pointer-i (indicatori) spre informatia continutd de acea
celula. A1:A4 reprezinta, pentru exemplul din figura, o insumare pe coloana, intre celulele A1
si A4. O notatie de genul A4:M4 ca argument la functia SUM reprezinta o insumare pe linie.
Sunt adunate inclusiv A1 si A4, respectiv A4 si M4, capetele intervalului.

Argumente functie g|

S

Mumberz

Adund toate numerele dinkr-o zona de celule.

Number1: numberl;numberz;... sunt de la 1 la 30 de numere de insumat, Yalorile
loqgice si kextele sunk ignorate in celule, inclusiv cele tastate ca argumente,

Rezultatul Formulei = 266,53

Ajukor pentry aceasts Funckie (o4 ] [ Rewvocare




Figura F.33.

Daca se cunosc abrevierile si sintaxele functiilor sau se doresc operatii aritmetice simple,
care se pot defini din tastatura, functiile de calcul pentru celula curenta se pot introduce si
direct (Figura F.34).
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Figura F.34.

In campul fx se introduce semnul egal (=) si apoi expresia care trebuie calculata. In celula
activa va aparea rezultatul acestui calcul.

In exemplul prezentat s-au considerat ,X” si ,Z” coordonatele unui punct in plan. ,R” este
distanta de la acel punct la originea sistemului de coordonate cartezian, calculatd dupa

formula matematica binecunoscuta (1).

R=vX?+Y? (1)

Este suficient ca aceasta definitie sa se dea pentru primul element din coloana, pentru ca ea
sa se poata extinde la intreaga coloana. Extinderea se face prin ,agatarea” cu mouse-ul a
patratelului negru din dreapta-jos a celulei marcate si deplasarea cursorului (care va fi in
forma de +) pe verticala in jos, peste toate celulele care se completeaza. Formula (1) se va
aplica pentru toate valorile X, Y. La sfarsitul selectarii, utilizatorul are posibilitatea de a
decide cum sa introduca datele calculate in celulele astfel selectate (Figura F.35).
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Figura F.35.

4.4 Inserare de obiecte in spatiul de lucru

in foaia de lucru Excel se pot insera in timpul lucrului linii, coloane, celule individuale cu
anumite caracteristici, se pot adauga foi de lucru in cadrul registrului care pot fi denumite
sugestiv. Inserarile se fac din meniul Inserare. Alte tipuri de date care se insereaza: imagini,
hyperlink-uri, nomograme, diagrame (reprezentari grafice cu date din foaia de lucru) etc. In
Figura F.36 este prezentata o astfel de diagrama creata cu programul Expert lansat de

Inserare->Diagrama... sau apasand pe butonul £ de pe bara de instrumente.

4.5 Operatii cu date

Se observa ca meniul specific Excel, care nu se regaseste in Word, este cel de Date. Aici
sunt grupate operatiile specifice cu datele continute in celule. Date->Sortare... realizeaza
sortarea si  ordonarea datelor selectate dupa anumite criterii  (coloane/linii,
ascendent/descendent, etc.). Date->Filtrare ofera posibilitatea filtrarii valorilor care se
reprezinta intr-o coloana dupa anumite criterii, astfel incat spatiul de lucru sa fie populat cu
mai putine date si lucrul s& se desfasoare mai rapid. in meniu se pot cere subtotaluri rapide,
rapoarte, se pot importa date din diferite surse, etc.



Microsoft Excel - Registruf |'-_||'E|g|
@_] Figier  Editare  Wizualzare Ingerare Format  Instrumente  Diagramd  Fereastrd  Ajutor
! Adobe POF

= =
SIE TR N - |

i9 R B U=

sl
Suprafata repr... = 15
A | B [ ¢ [ o [ E [ F [ & [ H [ 17
A i =
2312 30
26,12 31
2912 32
31 33

¥=1(x)

1'0 a0 = Suprafata diagramei

Y Y Y Y

—
4n)

)
[

v
4 4 » M)\ Fosel £ Foaie2 ' Foaie3 / |< | N

iDesenare g | Forme automate = N w [0 A Al 7 8] (@ | S e - A=
Gata UM

Figura F.36.

4.6 Formatarea paginii

Excel furnizeaza multe setari optionale astfel incat sa se poata modifica aspectul paginii ce
urmeaza a fi tiparita, prin fereastra multipla deschisa de Fisier->Initializare pagina... (Figura
F.37).

Initializare pagina

| Margini | Anket/Subsol | Foais

Orientare -
Imprimare, ..

|
[,
(%) Tip portret O Tip veders Examinare

Scalare Qpkiuni., .,

(%) Ajustare la; % din dimensiunea normald
3 potrivire la: EI pagini pe |atime pe inlgirme

Dirensiune hartie: |;5.4 210 x 297 mm b |

Calitatea imprimdri: | £00 dpi v

Mumarul primei pagini:

[ Ok l [ Revocare l

Figura F.37.

Orientarea foii de lucru imprimate poate fi setata tip portret sau tip vedere. Se comuta la tipul
vedere atunci cand trebuie tiparite mai multe coloane de date decat incap intr-o pagina tip
portret. Daca se doreste tiparirea numai tip portret, se modifica asezarea in pagina a foii de
lucru imprimate astfel incat datele sa incapa in spatiul disponibil sau se ajusteaza marginile.



Imaginea imprimata poate fi potrivita la pagina sau la dimensiunea hartiei prin restrangerea
sau extinderea imaginii. Celelalte modificari ce pot fi aduse asezarii in pagina a unei foi de
lucru imprimate includ dimensiunea hartiei, centrarea datelor pe pagina imprimata si controlul
modului de numerotare a paginilor. Aceste modificari afecteaza numai aspectul paginii
imprimate nu si modul in care aceasta apare pe ecran.

Pentru plasarea de numere de pagina sau alt text deasupra sau sub datele foii de lucru pe
fiecare pagina exista posibilitatea adaugarii de anteturi sau subsoluri la foaia de lucru
imprimata. Anteturile se imprima la inceputul fiecarei pagini; subsolurile apar jos pe fiecare
pagina. Pot fi utilizate anteturi sau subsoluri predefinite sau create de utilizator. Anteturile si
subsolurile sunt separate de datele de pe foaia de lucru si apar numai la examinare gi
imprimare.

Daca datele din foaia de lucru au etichete de rand sau de coloana (denumite si titluri de
imprimat), aceste etichete se pot repeta pe fiecare pagina din foaia de lucru imprimata.
Etichetele nu trebuie sa fie in primele randuri sau coloane ale foii de lucru. Este posibila si
imprimarea numerelor de rand sau a literelor de coloana dintr-o foaie de lucru (a nu se
confunda aceste titluri cu etichetele datelor). Anteturile si subsolurile, etichetele repetitive si
titlurile de rand gi de coloana pot fi utilizate in orice combinatie. Pentru aceasta se foloseste
comanda Figier->Initializare pagind... ->Foaie (Figura F.38.). Sunt posibile urmatoarele
variante:

e pentru imprimarea titlurilor de rand si de coloana se selecteaza caseta ,Titluri rénduri
si coloane” si ,Imprimare”.

e pentru a imprima etichetele coloanelor pe fiecare pagina, sub ,/mprimare titluri” din
caseta ,Réanduri de repetat la inceput” se introduc randurile care contin etichetele
coloanelor si apoi se selecteaza ,/Imprimare”.

e pentru a imprima etichetele randurilor pe fiecare pagina, sub ,/mprimare titluri’ din
caseta ,Coloane de repetat la stdnga” se introduc coloanele care contin etichetele
randurilor, si apoi se selecteaza ,Imprimare”.

Initializare pagina

Pagind | Margini | AntetiSubsol
Fona de imprimat: =5
Imprimare tituri

Randuri de repetat la inceput:

Coloane de repetat la skinga: =5
Irnprimare

[ Linii de gril& [ Titluri r&nduri 5i coloane

[ alb-negru Comentariis | {nici unul) w

[ Calicate tip schit Erotiin celule, ca: afisat
Crdinea paginilor

{* Ini jos, apoi lateral EE EIF EE

" Lakeral, apoiin jos EE EIE 5B

[ Ok ] [ Revocare
Figura F.38.

4.7 Vizualizare

.
Pentru a se vedea exact cum se va imprima fiecare pagina apasati butonul =% de pe bara de
instrumente sau selectati din meniul Fisier optiunea Examinare inaintea imprimarii. Se
vizualizeaza astfel anteturile, subsolurile si titlurile de imprimat.



Excel ofera urmatoarele cai de vizualizare a foilor de lucru si de aranjare a aspectului
imprimarii acestora:

Vizualizare->Normal, optiune implicita,

Fisier->Examinare inaintea imprimadrii, vizualizeaza pagina de imprimat astfel incat sa
se poata ajusta coloanele si marginile. Modalitatea in care apar paginile in fereastra
de examinare depinde de fonturile disponibile, de rezolutia imprimantei si de culorile
disponibile. Se vizualizeaza astfel anteturile, subsolurile si titlurile de imprimat.
Vizualizare->Examinare fragment de pagind, afiseaza datele care intra pe fiecare
pagina si permite ajustarea zonei de imprimat si a sfarsiturilor de pagina. Examinarea
sfarsiturilor de pagina arata unde intervin sfarsiturile de pagina in foaia de lucru si
care zona a foii de lucru se va imprima. Sfarsiturile de pagina setate de utilizator sunt
linii albastre continue, iar cele setate automat de Excel sunt linii albastre punctate.
Pentru a potrivi mai multe randuri sau coloane suplimentare in pagina curenta se
deplaseaza un sfarsit de pagina orizontal sau vertical. in Examinare fragment de
pagina, datele sunt restranse automat pentru a incapea in pagina. Este bine sa se
examineze inca o data pagina pentru a se vedea daca dimensiunea fonturilor nu este
prea mica. Pentru a se incheia o pagina intr-un anumit punct si a se incepe una noua
se seteaza un nou sfarsit de pagina.

Pe masura ce se fac setari care afecteaza modul in care se va imprima foaia de lucru,
aspectul se verifica prin comutarea intre diferitele tipuri de vizualizari pentru a controla
efectele Thainte de a trimite figierul spre imprimanta.



4.8 Optiuni de salvare

Salvarea registrelor se face in mai multe moduri:
e daca figierul de salvat a fost editat in sesiunea curentad selectati Figier->Salvare,

respectiv Ctrl+S sau butonul = de pe bara de instrumente. Figierul va fi salvat in
aceleagi conditii.

e daca figierul de salvat a fost creat in sesiunea curenta selectati Figier->Salvare ca... .
Fisierului i se poate atribui un nume, un tip (alta extensie) din lista care se deruleaza
sub eticheta , Tip fisier:”, schimba locatia.

Excel va ofera posibilitatea de a salva un spatiu de lucru. Un figier spatiu de lucru este un
fisier care salveaza informatiile de afisare despre registrele de lucru deschise, astfel incat sa
se poate relua lucrul ulterior cu aceleasi dimensiuni ale ferestrei, zonei de imprimat, marire a
ecranului si setari de afisare, fara a contine insa registrele de lucru propriu-zise. La
deschiderea unui astfel de figier, Excel va deschide fiecare registru de lucru salvat in spatiul
de lucru. Pentru a crea un figier spatiu de lucru deschideti registrele de lucru pe care vreti sa
le salvati in spatiul de lucru, dimensionati si aranjati fereastra registrului de lucru dupa cum
doriti sa apara la deschiderea spatiului de lucru gi in meniul Figier selectati optiunea Salvare
spatiu de lucru. in cdmpul Nume de fisier, tastati un nume pentru figier.

4.9 Imprimarea figierelor

Pentru a imprima numai anumite portiuni dintr-o foaie de lucru se selecteaza cu mouse-ul
zona respectiva si din meniul Figier se alege optiunea Zona de imprimat, apoi Stabilire zona
de imprimat. Pentru adaugarea de celule la o selectie existentd in meniul Vizualizare
selectati optiunea Examinare fragment de pagind, selectati celulele pe care doriti sa le
adaugati zonei de imprimat, apoi dati click dreapta in zona celulelor de adaugat si din meniul
contextual alegeti optiunea Adéugare la zona de imprimat.

Pentru golirea unei zone de imprimat din meniul Figier selectati Zona de imprimat, apoi
Golire zona de imprimat.

Registrul curent se poate tipari (imprima) prin selectarea comenzii Figier->Imprimare..., sau

apasarea simultana a tastelor Ctr/+P, respectiv apasarea butonului = de pe bara de
instrumente. In toate situatile se deschide o fereastra in care se definesc parametrii de
tiparire in acelasi mod ca in Word.



5. Microsoft PowerPoint

Crearea unei prezentari in Microsoft PowerPoint presupune:
e pornirea de la o forma de baza,
e adaugarea de noi diapozitive si continut,
e alegerea aspectelor,
e modificarea aspectului diapozitivelor prin modificarea schemei de culori sau prin
aplicarea unor sabloane forma diferite,
e crearea de efecte (de exemplu tranzitiile animate intre diapozitive).

5.1 Crearea unei prezentari noi

Dupa lansare, PowerPoint se deschide cu o pagina de prezentare goala (Figura F.39). O
prezentare noua se deschide si daca in timpul unei sesiuni de lucru PowerPoint se alege

secventa Fisier->Nou..., respectiv se apasa butonul 1 de pe bara de instrumente de lucru.
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Meniul din partea dreapta ofera o serie de posibilitati de a incepe crearea unei prezentari:

e Prezentare noud. Se incepe cu diapozitive cu un aspect minim si fara culori aplicate.

e Din sablon forma. Prezentarea se creeaza pe un sablon PowerPoint ce are deja un
concept de forma, font-uri si 0 schema de culori. Suplimentar fata de sabloanele care
insotesc PowerPoint, exista posibilitatea de a se folosi sabloane create de utilizator.

e Din Expertul continut determinat automat. Se utilizeaza un Expert pentru a aplica un
sablon forma care include sugestii pentru textul diapozitivelor personale si se
introduce textul dorit (Figurile F.40-41).

e Din prezentare existenta. Prezentarea noua se creeaza pe baza uneia deja scrise si
desenate. Aceasta comanda creeaza o copie a prezentarii existente pe care se fac
modificarile de forma si continut dorite pentru prezentarea noua.



Album foto. Se deschide o fereastra de dialog in care utilizatorul poate alege un
folder contindnd poze pe care sa-l transforme intr-o prezentare PowerPoint (Figurile
F.42-44)

Sabloane la Office Online. Se alege dintre sabloanele PowerPoint suplimentare care
se regasesc pe site-ul Microsoft in sectiunea Sabloane.

Pe computerul meu.

Pe site-urile mele de Web, se creeaza o prezentare cu ajutorul unui sablon amplasat
pe un site Web.

Din Expertul continut determinat automat

Expert autocontinut - [Recomandarea unei sirategii]

Seleckati lipul prezentarii pe care dariti 58 o sustinet

Generalitati

Fecomandarea unei skrakegii
Comunicarea vestilor neplacute
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Sesiune de lucru
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Pornire Taotald

Tip prezentare General

Stil prezentare Corporatig

Proiecte
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Wanzari [ Marketing
Terrninare

[ﬂdéugare...] [ Eliminare: l

[ Revocare l [ < Inapoi ][grmétcurul.‘:] [ Terminare ]

Figura F.40

Tn cadrul fiecarui ecran utilizatorul va trebui s& selecteze, pe rand, tipul de prezentare, stilul si

optiunile de prezentare.

Aceasta este structura pentru o prezentare de tipul Recomandarea unei strategii propusa de
aplicatie. Dupa cum se poate observa este definita din punct de vedere grafic si structural, si,
de asemenea, cateva sfaturi utile in crearea acestei prezentari.
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In aceasta etapa utilizatorul isi va defini prezentarea, avand totodatd posibilitatea de a
prelucra fotografiile, la un nivel nu foarte avansat, insa.
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Prezentare nouéa

Pentru crearea unei prezentari cu ajutorul diapozitivelor necompletate, se deschide un figier
nou, cu optiunea Prezentare noud. Se introduc titlul si subtitlul in zonele in care le cere
aplicatia (Figura F.45.).
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Prezentarea este de fapt o succesiune de diapozitive, fiecare aparand pe ecran ca o pagina
separata. Pentru adaugarea de noi diapozitive dupa cel curent in meniul Inserare se
selecteaza Diapozitiv nou, se apasa simultan tastele Ctrl si M sau se foloseste butonul
biapozitivnou de pe bara de instrumente. Se adauga astfel pagini in care utilizatorul poate sa
introduca datele pe care le doreste:



e imagini, cu Inserare->Imagine->Din figier... sau din alte surse posibile (Figura F.46),
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Figura F.46.

o diagrame, cu Inserare->Diagrama. Apare un sablon de diagrama care va fi
particularizata (buton dreapta mouse, Obiect chart/Edit) (Figura F.47),
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e text, direct de la tastatura sau prin copierea din alte aplicatii (textul se editeaza si se
formateaza prin selectarea de optiuni de pe lista aparuta prin click in spatiul de lucru)
(Figura F.48).
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In prezentare se pot insera sunete, tabele, nomograme, obiecte generate in alte aplicatii,
comentarii, data si ora etc.

In partea din stinga a ecranului se observa o listd a tuturor diapozitivelor introduse in

prezentare, in fila Diapozitiv (@). Prin selectarea filei Schita (|/ =) se obtine lista entitatilor
adaugate in prezentare (Figura F.49), care se alcatuieste automat, pe masura ce utilizatorul
le defineste interactiv.

Se observa din Figura F.49 ca apasarea butonului de derulare din dreapta butonului
Prezentare noua ofera mai multe optiuni, printre care schemele de forma, culoare si
animatie, menite sa faca prezentarea mai interesanta.
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Tn timpul lucrului, daca utilizatorul doreste schimbarea sablonului de prezentare, o poate face
prin selectarea unei alte scheme de forma si culoare din listele existente, aplicabila tuturor
diapozitivelor din prezentare sau doar celor specificate (Figura F.50).

B Microsoft PowerPoint - [Prezentare test. ppt]

@ Figier Editare Wzualizare Inserare Format  Instrumente  Expunere diapozitive Fereastrd  Ajutor  Adobe PDF dimensiunile ferestrei cores » X
dﬁﬂj\ﬁlﬂl@ﬂlﬂ-l[ﬂﬁlﬁ g iaa -8 - B 1 U [[E] " = | A - | o/ Forma =) Dispozitiv nou &
Forma diapozitiv > X
1 @8 |k
it =y Fabloane farma
22} Scheme culari
Intfroducere text =
2 [op— Se aplica sablon forma:
i i . . i - Utilizat in aceasta _
*+ Meniul din partea dreaptd oferd o serie de posibilitati de CreEEEe
a incepe crearea unei prezentari:
3 * Prezentare noud. Se incepe cu diapozitive cu un aspect
minim si fard culori aplicate.
* Din sablon formé&. Prezentarea se creeaza pe un sablon e L
PowerPoint ce are deja un concept de forma, font-uri si o
4 schemd de culori. Suplimentar fatd de gabloanele care
insotesc PowerPoint, existd posibilitatea de a se folosi
sabloane create de utilizator.
* Din Expertul confinut determinat automat. Se utilizeaza -
un Expert pentru a alpllca un sablon formé care include
sugestii pentru textu dlap02|t|\.relor personale sis G e (D e Gt |
introduce textul dorit (Figurile F.41-42). 0 s apic s dispoitvsle selectate -
| Utilizare pentru toate prezentarile noi I
Afigare examindri mari :-
=k ) Se face clic pentru adaugare note 3 RisFaire...
| ,Desegare'm‘ Forme automate = N, N [ (O A 4 f:ﬁ (8] (& & - - A' == E i Ij!
—
II Diapozitiv ¢ din ¢ Model implicit Romand (Romania) [EES

Figura F.50.



Tot pentru acest scop exista meniul Expunere diapozitive, cu ajutorul caruia se ,regizeaza
prezentarea, se defineste modul cum se vor derula diapozitivele, se configureaza expunerea,
se fac inregistrari, etc. Utilizatorul are posibilitatea de a verifica derularea expunerii pe
masura ce o defineste, cu ajutorul optiunii Vizualizare Expunere (tasta F5).

In cazul in care este necesar intreg spatiul ecranului pentru lucru, utilizatorul poate inchide
lista din dreapta, apasand pe butonul marcat cu ,x” din dreapta butonului de derulare.

Se pot crea prezentari noi prin copierea si modificarea celor existente sau se pot folosi
diversele sabloane furnizate de PowerPoint.

5.2 Lucrul in PowerPoint

Cu ajutorul PowerPoint se pot deschide prezentari create in PowerPoint sau in alte aplicatii,
cum ar fi Harvard Graphics si Lotus Freelance. La deschiderea acestor tipuri de prezentari in
PowerPoint o mare parte din continutul si formatarile originale sunt pastrate. Prezentarile
create in alte programe decat Harvard Graphics si Lotus Freelance pot fi deschise in
PowerPoint utilizadnd formate de fisiere textsi grafice. Formatele text pastreaza textul
prezentarii. Mai indicat este formatul ,.rtf"” (Rich Text File) care, pe langa text, pastreaza si
unele formatari. Salvarea unei prezentari intr-un format de fisier grafic presupune salvarea
fiecarui diapozitiv sub forma unei imagini grafice separate care apoi se va insera in
prezentarea PowerPoint. Daca existda prezentari gata facute, dar care trebuie editate,
PowerPoint se poate deschide prin dublu click pe numele figierelor respective si va afisa la
deschidere continutul deja existent in ele. Altfel, daca PowerPoint este deja deschis si se
doreste sa se lucreze si la alte fisiere, deja existente, ele se deschid cu Fisier->Deschidere...
sau prin apasare pe butonul L de pe bara de instrumente. Se observa ca in PowerPoint se
pot deschide fisiere de formate diverse, nu neaparat implicitul ,.ppt”’. In fereastra de
deschidere se pot vizualiza prin derularea listei Fisiere de tip: toate extensiile recunoscute
de PowerPoint.

In PowerPoint pot fi deschise simultan mai multe prezentri, se pot copia texte si obiecte din
una in alta prin intermediul clipboard-ului (asa cum a fost descris in capitolele precedente).
Gestionarea prezentarilor multiple se realizeaza cu ajutorul meniului Fereastra.

Atentie: deschiderea de prezentari multiple, desi suportatda pana la o anumita limita,
incetineste vizibil functionarea aplicatiei, mai ales in cazul figsierelor mari. Este indicat sa se
salveze periodic, cu grija, continutul prezentarilor deschise si sa se inchida cele de care nu
mai este nevoie in sesiunea curentad pentru a se preveni pierderea de date prin inchideri
accidentale.

in foaia de lucru PowerPoint poate fi folosit butonul dreapta al mouse-ului. Tn functie de locul
unde este apelat si de entitatile selectate se va deschide o listd de comenzi gi optiuni
contextuala.

5.3 Vizualizarea prezentarilor

PowerPoint ofera urmatoarele cai de vizualizare a foilor de lucru si de aranjare a aspectului
imprimarii acestora:
e Vizualizare->Normal, optiune implicita, se vizulizeaza un singur diapozitiv pe pagina.
o Vizualizare->Sortare diapozitive, pentru a vedea mai multe diapozitive pe pagina de
lucru. Aici puteti modifica ordinea diapozitivelor,
o Vizualizare->Expunere diapozitive, sau tasta F5, pentru vizualizarea configurarilor
facute,
e Vizualizare->Panoramare, pentru marirea scarii de prezentare etc.
e Fisier->Examinare inaintea imprimdrii, vizualizeaza pagina de imprimat (cu formatul
definit in Figier->Initializare pagina...). lesirea din fereastra de examinare se face
apasand butonul inchidere de pe bara de instrumente.



5.4 Salvarea prezentarilor

Salvarea prezentarilor se face in mai multe moduri:

e cand fisierul de salvat a fost editat in sesiunea curenta se selecteaza din meniul
Figier optiunea Salvare, se apasa simultan tastele Cirl si S sau se foloseste butonul

= de pe bara de instrumente.

e cand fisierul de salvat a fost creat in sesiunea curenta si nu are nume atribuit de
utilizator, respectiv atunci cand fisierul se salveaza cu altd extensie din lista care se
deruleaza sub eticheta Tip figier: sau se doreste modificarea locatiei acestuia, se

selecteaza Figier->Salvare ca....

5.5 Imprimarea prezentarilor

Exista posibilitatea de a se imprima intreaga prezentare (diapozitivele, schitele, paginile de
note etc.) in culori, in tonuri de gri sau alb-negru. Exista, de asemenea, posibilitatea de a se
imprima numai anumite diapozitive. Prezentarea curentd se poate tipari prin selectarea
comenzii Figier->Imprimare..., sau apasarea simultana a tastelor Ctrl si P, respectiv

apasarea butonului = din bara de instrumente. in toate situatiile se deschide o fereastra in

care se definesc parametrii de tiparire (Figura F.51).
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6. Microsoft Outlook

6.1 Posta electronica

Dupa lansare se deschide fereastra generala Outlook (Figura F.52), implicit pe optiunea
Outlook Azi (modul de lucru posta electronica).
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Se observa in partea stanga o lista de directoare specifice pentru posta electronica,
structurate Tn doua sectiuni, avand in vedere frecventa de folosire, astfel au fost definite
folderele preferate: Inbox (mesaje primite), Sent Items (mesaje trimise), Deleted Iltems
(mesaje sterse), Drafts (mesaje In curs de pregatire) si toate folderele, care pe langa cele

amintite mai sus, includ Junk E-mail (mesajele de posta nedorite), Outbox (mesaje de trimis),
Foldere de cautare.

Ca si In celelalte aplicatii sub Windows, butonul din dreapta al mouse-ului apasat in anumite
zone sau, ca in cazul de fata, 1danga anumite icoane, produce liste de comenzi contextuale.

Astfel posta electronica poate fi deschisa in fereastra separata, se pot seta criterii de cautare
contextuala in lista de mesaje etc.

Tot prin apasarea butonului din dreapta al mouse-ului l&anga etichetele unor activitati din
agenda, persoane de contact etc. se pot edita atributele si proprietatile acestora.

Posta electronica functioneaza, in principiu, la fel ca si in Outlook Express, cu mai multe
posibilitati de particularizare (Figura F.53), ca de exemplu definirea de grupuri de persoane
de contact, crearea de machete de corespondenta etc.
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Pentru scrierea unui mesaj nou se selecteaza Actiune->Mesaj corespondentd nou (Ctrl+N),
respectiv Mesaj nou de postéa electronica utilizand... cu selectarea unei optiuni din lista care

apare (Figura F.54.).
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Noul filtru Posta electronica nedorita ajuta la oprirea multor mesaje nedorite pe care le primiti
zilnic. Utilizeaza o tehnologie revolutionara dezvoltata de Microsoft Research pentru a evalua
daca un mesaj va fi tratat ca nedorit bazdndu-se pe cativa factori, precum timpul cand a fost
trimis si continutul mesajului. Filtrul nu elimina vreun expeditor particular sau tip de posta
electronica; el se bazeaza in general pe continutul mesajului i utilizeaza o analiza avansata
a structurii mesajului pentru a determina probabilitatea ca acesta sa fie posta electronica
nedorita. Orice mesaj capturat de filtru este mutat in folderul Junk E-mail (Posta electronica
nedoritd), unde poate fi regasit si revazut mai tarziu. Optiunile acestui filtru pot fi modificate
selectdnd Optiuni din meniul Instrumente si apoi fila Preferinte. Aici se regaseste butonul
Posté electronica nedorita. Apasand acest buton va fi afisata o fereastra cu patru file Optiuni
(nivelul de filtrare), Expeditori siguri (definirea unor liste prin care mesajele acestor expeditori
nu vor fi tratate niciodata ca posta electronica nedorita), Destinatari siguri (definirea unor liste
prin care mesajele catre acesti destinatari nu vor fi tratate niciodata ca posta electronica
nedoritd), Expeditori blocati (definirea unor liste prin care blocati mesajele de la anumite
adrese de posta electronica sau nume de domenii).

Folderele de cautare contin rezultatele actualizate permanent ale cautarilor tuturor
elementelor de posta electronica ce indeplinesc anumite criterii de cautare. Vedeti toate
mesajele de posta electronica necitite din fiecare folder din cutia dumneavoastra postala,
intr-un folder de cautare numit Unread Mail (Corespondenta necitita). Pentru a va ajuta sa
reduceti dimensiunea cutiei postale, folderul de cautare Large Mail (Corespondenta
voluminoasa) afiseaza corespondenta cea mai lunga din cutia postala, indiferent de folderul
in care sunt stocate mesajele. Un alt astfel de folder este For follow up (Corespondenta de
urmarit). De asemenea, aveti posibilitatea sa creati propriile foldere de cautare: Figier-> Nou
-> Folder de cautare cand puteti alege dintr-o lista cu gsabloane predefinite sau sa creati o
cautare cu criterii particularizate.

6.2 Calendarul

La apasarea butonului Calendar, | de pe panoul din partea stidnga sau

selectarea optiunii Calendar din meniul Salt la, respectiv apasarea simultana a tastelor Ctr/ si
2, Outlook intra in modul de lucru respectiv si afigeaza o pagina de calendar insotita de
agenda zilei curente si o listd de activitdti (Figura F.55). In pagina de agenda se pot
programa activitati prin selectarea optiunii Rezervare noué din lista aparuta prin click dreapta
al mouse-ului sau din meniul Actiuni. Se observa ca existda mai multe activitati posibile. De
asemenea, se pot defini sarcini sau intalniri pentru viitor, prin selectarea zilei din calendarul
care apare in pagina. Lunile se deruleaza apasand pe sagetile sub forma de triunghi de
l&nga calendar in directia dorita.

Observatie: Meniurile Vizualizare si Actiuni cuprind un set de comenzi comune aplicatiilor din
Outlook, dar majoritatea comenzilor si optiunilor de aici sunt specifice fiecarui mod de lucru
in parte.
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6.3 Persoane de contact

Este similar agendei ,Addresses” din Outlook Express, dar aici exista posibilitatea de a defini
persoane de contact, cu mai multe detalii, prin intrarea Tn acest mod de lucru (selectarea
g&j Persoane de contact ‘

butonului Persoane de contact din tableta din stédnga ecranului,
selectarea optiunii Persoane de contact din meniul Salt la, respectiv apasarea simultana a
tastelor Ctri si 3) .

Tn meniul Actiuni al acestui mod de lucru apar comenzi specifice: Persoana de contact nou&
(Ctrl+N) (Figura F.56), in general sau in aceeasi companie, crearea listelor de distribuire,
stabilirea de activitati diverse in legatura cu persoana respectiva etc. Se observa ca definirea
de persoane de contact este complexa. Datele acestei agende se pot salva intr-un figier de
format ,.txt” sau ,.rtf” pentru imprimare sau in formate specifice, portabile catre alte aplicatii
de birou.
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6.4 Activitati
Prin selectarea butonului Activitati, | 21 netin | sau a optiunii Activitati din meniul Salt

la, respectiv apasarea simultana a tastelor Cirl si 4, se deschide un mod de lucru in care se
stabilesc activitati, cu parametri si atribute specifice (Figura F.57).
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n exemplul prezentat se observa ca este definita o actiune: ,Curs”, actiune in curs de
desfasurare, cu datéd de scadentd. Daca se va reveni la modul de lucru Calendar, se va
observa ca aceste doua activitati sunt listate sub titlul Mapa de activitati. De asemenea, daca
se va reveni la modul de lucru in posta electronica, Outlook Azi, activitatea definita va apare
in lista Activitati. Se observa astfel ca Outlook face corelatii intre modurile de lucru (activitati-
persoane-calendar-corespondentd), astfel incat existd mai multe criterii de urmarire a unei
agende de lucru (ce trebuie facut, cine se implica, data si durata, cine va fi anuntat etc.).
Toate acestea se leaga si de ideea gruparii persoanelor care au activitati comune si de
schimbarea de mesaje prin posta electronica diferentiat pe grupuri. Activitatea noua se
defineste alegand optiunea cu acest nume din lista din figura, rezultatd in urma apasarii
butonului din dreapta al mouse-ului in spatiul de lucru, respectiv selectand Actiuni->Activitate
noua (Ctrl+N). in fereastra care se deschide se definesc: titlul activitatii, starea, data de
pornire, scadenta etc.

6.5 Note

Selectarea butonului Note, =l sau a optiunii Note din meniul Salt la, respectiv apasarea
simultana a tastelor Cirl si 5, produce aparitia unei ferestre (Figura F.58) in care se pot defini
notite de ingtiintare rapide care pot fi apoi trimise unor grupe de persoane de contact (click
dreapta pe una dintre not si selectarea optiunii Redirectionare din meniul contextual).

Notes - Microsoft Outlook
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Figura F.58.

Prin trimitere, pe desktop-ul destinatarilor vor aparea mici ingtiintari care imita biletelele tip
Post It (Figura F.59).



ﬁur'sul se va incheia cu
testarel

26.08.2005 14:22 bl

Figura F.59.

Pentru ca Outlook sa functioneze mai mult decat ca un simplu client de posta electronica, in
reteaua interna trebuie sa fie definit un server de tip Microsoft Exchange. Acesta va face
posibila dezvoltarea unor aplicatii de tip colaborare pe grupuri, gestionarea sarcinilor, lucru in
echipa (de exemplu pentru stabilirea etapelor de dezvoltare ale unui proiect) cu posibilitati de
comunicare rapida (notite instantanee aparute pe ecranul unui alt utilizator).



7. Microsoft Access

Dupa lansare, Access se deschide cu o pagina goala (Figura F.60). Acelasi lucru se
intdmpla si daca in timpul unei sesiuni de lucru Access se alege secventa Figier->Nou...,

respectiv se apasa butonul Jde pe bara de instrumente.

Microsoft ficcess |:||E”X|

I Figiet Editare Wizualizare Inserare  Inskrumente  Fereastr  Ajukor Tastati ointrebare -

Nou
Biazd de date necompletata. ..

Pagind necompletatd de acces lac

£ .| W,

Proiect care utiizeazs date exister
Proiect care utilizeaza date noi, .
i_éﬂ Din figier existent. ..

abloane
CAukare inkeractiva pentru:

(

Sal
%8 gabloane la Offics Online
Pe compukerul me. ..

Gata MUM e
i |

Figura F.60.

Fereastra noua Access (Figura F.61) prezintd in partea dreapta doua sectiuni: Nou si
Sabloane. In sectiunea Nou, se regasesc urmétoarele variante:

e Baza de date necompletatd. O baza de date reprezinta o colectie de informatii care
se refera la un anumit subiect sau scop, de exemplu o listd de persoane insotita de
informatii despre ele (varsta, adresa, functia, respectiv informatii daca au parcurs
anumite cursuri, rezultate la testari, etc.). Este entitatea de baza de care se leaga
toate celelalte aplicatii Access (pagini de acces, proiecte). Cuprinde informatii stocate
in tabele corelate intre ele prin chei, in care coloanele se numesc ,campuri” iar liniile
Jnregistrari”.

e Pagind necompletatd de acces la baza. Se deschide o fereastra din care puteti
selecta sursa de date aflata la distanta, dupa care sunteti ghidati in definirea instantei
bazei de date cu ajutorul unui expert.

e Proiect care utilizeaza date existente si Proiect care utilizeaza date noi. in Access, un
proiect este un fisier de date care furnizeaza accesul eficient la o baza de date.
Contine formulare, rapoarte, numele si amplasarea paginilor de acces la date,
macrocomenzi si module scrise in SQL (Standard Query Language) si nu date sau
definitii de date (tabele, vizualizari, diagrame de baze de date, proceduri stocate sau
functii definite de utilizator).

o Din fisier existent. Baza de date va avea ca punct de plecare o baza de date care a
fost deja creata.

in sectiunea Sabloane, se regasesc urmatoarele variante:

e Sabloane la Office Online. Utilizatorul poate apela la sabloane care se regasesc pe
site-ul Microsoft.

e Pe computerul meu. Cuprinde sabloane predefinite pentru cele mai utilizate tipuri de
baze de date.

Daca exista fisiere care trebuie editate, Access se poate deschide prin dublu click pe numele
fisierelor respective si va afigsa la deschidere continutul acestora. Altfel, daca Access este



deja deschis si se doreste sa se lucreze si la alte fisiere, deja existente, ele se deschid cu
Fisier->Deschidere... sau prin apasare pe butonul ' de pe bara de instrumente. Se observa
ca in Access se pot deschide fisiere de formate diverse, nu neaparat create cu Access
(implicitul ,.mdb”). In fereastra de deschidere se pot vizualiza prin derularea listei Fisiere de
tip: toate extensiile recunoscute de Access. In foaia de lucru Access poate fi folosit butonul
din dreapta al mouse-ului. in functie de locul unde este apelat si de entitatile selectate se va
deschide o lista de comenzi gi optiuni contextuala.

Ca exemplu se va crea un fisier nou, de tip Baza de date necompletata simpla, formata dintr-
un singur tabel. Utilizatorul introduce numele bazei, dupa care se deschide o fereastra de
selectie (Figura F.61) a metodei de creare a tabelului respectiv.

& bd{ : Baza de date (format figier Access 2000)

Deschiders B Proiect “SINou | X | 2o
Obiecte |Z|_=J iCreare tabel in madul Vizualizare proiect:
| 2 Tabele |Z|_=J Creare tabel utilizénd Expertul

§ Tl IE_J Creare tabel prin introducere de date
== Formulare
43 Rapoarte
¥4 Pagini
2 Macroca...
&t Module

Grupuri
%] Preferinte

Figura F.61.
Mai intuitiva este utilizarea programului tip Expert Tabel (Figura F.62).

Expertul contine o serie de tipuri de tabele specifice unor activitati mai uzuale, din care
utilizatorul poate sa aleaga. Fiecare tip de tabel are predefinit si capul de tabel (lista
campurilor), pe care utilizatorul le poate selecta pentru tabelul sau. Defilarea ferestrelor se
face apasand butonul ,Next>". In urmétoarele ferestre se stabileste campul principal al
tabelului, numit ,cheie primara” (Primary Key). Aceasta cheie primara este formata din
inregistrari cu valori unice (care nu se repeta). S-a ales tabelul tip ,Studenti”, cu cateva din

campurile din sablon, cheia primara ,,/DStudent” (identificatorul studentului).
Expert tabel

Care dintre exemple de tabele afisate mai jos doriti 53 11 utilizati pentru crearea tabelului?
Dupa ce seleckati o categorie de tabel, alegeti tabelul si campurile exemplu pe care doriti <3 le
includeti in noul tabel, Tabelul nu poate contine campuri din mai mult de un tabel exemplu, Dacs
nu sunkeki sigur asupra unui cdmp, continuati si includeti-l, mai tarzio wa i mai simplu sa stergeti
un camp.
(®)De afaceti Exemple de cimpuri: Campuri din tabelul nou:
Adresa ~ IDSkudent
Persanal -
Oe Localitste Prenume
Exemple de tabele: StakSauProvincie MumeDeFamilie
A = CodPostal
clve A1 Mum&rTelefon -
E\tldent‘zurewzn NumePogt&Electronicd
ranzacki Curs -
et L
Ackivitaki Mumarstudent -
Argsia ey
[ Urmatorul = l ’ Terminare ]
Figura F.62.

Se deschide un tabel care se completeaza de catre utilizator (Figura F.63).
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Figura F.63.

In lista de comenzi rezultatd prin apasarea butonului din dreapta al mouse-ului in spatiul de
lucru se gasesc comenzi din meniul Inregistréri, Editare, respectiv Inserare. Datele cAmpului
respectiv se pot sorta, filtra, etc. Din meniul Insert (Inserare) se pot insera cdmpuri (coloane)
si Tnregistrari (linii) la stanga celulei in care se afla cursorul, respectiv la sfarsitul tuturor
inregistrarilor. Tabelul se poate salva in mai multe forme (ca tabel, raport, formular, respectiv
pagina de acces la date). Definirea paginii, vizualizarea si tiparirea se fac similar cu celelalte
aplicatii Office. Cu referire la baza de date creatd deja se pot crea interogari, formulare,
rapoarte etc., selectand entitatile respective (Figura F.64.), aceasta fereastra de baza
ramanand rezidenta in spatiul de lucru.
Microsoft Access - [test : Baza de date (format figier Access 2000]]

5 Fisier Editare  Wjzualizare Inserare Instrumente  Fereastrd  Ajutor Tastati ointrebare 8/ X

Eﬁgeschidere & Proiect  SMou | K | 2o
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@ = Creare tabel prin introducers de date
Inkeragari
: =
Formulare
Rapoarte
@ Pagini
2 Macroco..,
& Module
Grupuri

[#] Preferinte

Gata UM

Figura F.64




8. Instalarea/eliminarea componentelor individuale din Office 2003

Daca Microsoft Office Professional 2003 a fost instalat dintr-un server de fisiere in retea sau
dintr-un director partajat, instalarea sau eliminarea (dezinstalarea) componentelor se va face
tot de la aceasta amplasare. La fel se procedeaza daca suportul de instalare a fost CD-
ROM-ul local sau unul existent pe un alt calculator din retea.

Se parcurge secventa:
Start -> Control_Panel -> Add_or_Remove_Programs

Rezultd o fereastra in care sunt listate toate programele instalate de utilizator (care nu
apartin sistemului de operare instalat initial).

Apasarea pe butonul ,Remove” va elimina in intregime sau la alegere componentele Office.
Prin apasarea butonului ,Change” se deschide fereastra Expert din Figura F.65, in care
utilizatorul Tsi poate alege varianta preferata.

Tnainte de orice adaugare sau eliminare de software de orice tip este bine sa se realizeze o
copie de siguranta a aplicatiilor pe un suport extern, de unde sa se poata restaura in caz de
defectiuni majore. Aceasta trebuie sa faca parte dintr-o politica de backup & restore agreeata
de toti utilizatorii calculatorului respectiv si administratorul retelei din care acesta face parte.

& Microsoft Office Visio Standard 2003 Setup =

Microsoft Office ¥isio Standard 2003

Maintenance Mode Options

@fﬁdd ot Remove Features
i_hange which Features are installed or remove specific Features. i

@ Reinstall or Repair
'n (") Reinstall or Repair Microsoft OFfice Yisio Standard 2003 to its original
stake,

Cin
il
@ Uninstall
Ininstall Microsoft Office Yisio Standard 2003 from this computer,

[ Mext = l [ Zancel

Figura F.65.



9. Ce este nou in Office 2003

Noutatile aduse de Office 2003 fata de versiunile anterioare (97, 2000, XP) sunt prezentate
sistematizat de catre Microsoft pe site-ul propriu, in locatia:

http://www.microsoft.com/office/editions/prodinfo/compare.mspx

Caracteristicile prezentate ar putea fi grupate Tn urmatoarele categorii:
e modul de lucru colaborativ:

0 se pot crea spatii de lucru (este necesar un server Microsoft Windows 2003
pe care sa ruleze Windows SharePoint Services). Acestea simplifica procesul
de colaborare in ceea ce priveste crearea, modificarea si revizuirea figierelor.
Unele dintre aceste trasaturi au existat si inainte, de exemplu, integrarea
serviciilor Windows SharePoint disponibila in FrontPage 2002, calendare
multiple in Outlook XP, exportul de informatii cu privire la anumite evenimente
comune membrilor unei echipe direct intr-un calendar Outlook n XP,
disponibilizarea informatiilor despre starea anumitor utilizatori prin intermediul
internet-ului in XP gi 2000, toate acestea caracteristici fiind imbunatatite.

e gestionarea modificarilor in documente:

o Tn Word 2003 au fost introduce cateva caracteristici noi: definirea unor zone
de restrictionare a editarii sau a modificarii stilurilor documentelor;

o la nivelul intregului Office a fost introdus serviciul IRM (Information Rights
Management — Managementul drepturilor de accesare a informatiei);

o au fost imbunatatite caracteristicile de revizuire si acceptare/respingere a
modificarilor facute de alti utilizatori, serviciul de utilizare a semnaturii digitale,
folosirea serviciului de incriptare a parolelor.

e evitarea supraincarcarii contului de e-mail

0 o trasatura noua o reprezinta alertarea utilizatorului despre sosirea unor noi
mesaje, mesajele putand fi deschise sau sterse din aceasta fereastra de
notificare;

0 Outlook 2003 pune la dispozitia utilizatorului de doua ori mai mult spatiu
pentru citirea mesajelor cu ajutorul panourilor de examinare (existente si in
XP, dar imbunatatite in aceasta editie), tot aici puteti deschide atasamentele
fara a fi nevoie sa deschideti mesajul insusi, vizualiza diferite informatii despre
mesaj, etc.

o Tmbunatatirea serviciilor de filtrare a mesajelor nefolositoare.

e organizarea Inbox-ului

0 caracteristica noua o reprezinta posibilitatea de a aranja mesajelor dupa
criteriul Conversatie, cand sunt vizualizate mesajele necitite sau cele marcate;

o utilizatorul are la dispozitie acum sase tipuri de stegulete pentru a marca
mesajele. in folderele de cautare, in folderul For follow-up vor putea fi
vizualizate toate mesajele astfel marcate.

o flexibilitate:

o compatibilitati cu formate multiple, din versiuni anterioare sau din alte aplicatii,

o capabilitati noi de lucru XML (Extensible Markup Language, in principiu, este
un limbaj care permite crearea de comenzi in documente, pentru a specifica
modul cum acestea vor fi folosite sau formatate. Este specific pentru crearea
documentelor Web.) in Word, Excel si Access,

0 instalare, administrare si intretinere facila,

0 localizarea in limba romana,

o posibilitati de a primi ajutor de pe Web etc.

e cresterea productivitatii si simplificarea lucrului:

o accesul rapid la diferite surse informatii (optiunea Cercetare este o
caracteristica noua);

o implementarea optiunii Citire;

0 includerea pachetului pentru CD si a icoanelor de tip Smart Tag in cadrul
aplicatiei PowerPoint;


http://www.microsoft.com/office/editions/prodinfo/compare.mspx
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o

prezenta asistentilor inteligenti care furnizeaza informatii si semnaleaza
greseli interactiv, in timpul lucrului (de exemplu, icoanele Smart Tag care apar
la lipirea de date copiate sau mutate, care permit formatarea rapida a
paragrafului copiat, intr-un mod la alegerea utilizatorului),

formatari rapide, acces la Web pentru extragerea de sabloane,

optiunile de autocorectare in timpul lucrului,

recunoasterea vorbirii si a scrisului de mana,

ajutorul rapid de tipul , Tastati o intrebare”,

recunoasterea automata a tipului informatiei (de exemplu, la introducerea unei
adrese de Web, a datei calendaristice etc.),

accesul pe Web, la galerii de sabloane si documente, in orice moment al
lucrului,

inserarea rapida a hyperlink-urilor etc.
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